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Preface
ClusterSeer provides data visualization tools and state-of-the-art statistical
methods to explore spatial and temporal patterns of disease and other
events.
ClusterSeer methods can be used to investigate clusters of events in space,
in time, and spatial clusters that depend on time (spatio-temporal interaction).
Use the method of your choice, or find an appropriate method using the
ClusterSeer Advisor available within the software.
System requirements
•

Windows 95 or Windows NT 4.0 or more recent operating system

•

Screen resolution of 800 X 600 or finer for best viewing of the maps
and graphics

•

256 colors or better highly recommended for graphics

•

15 MB hard drive

•

128 MB RAM (minimum), 256 MB RAM (recommended)

•

P3 500 MHz (recommended) Processor Speed

Manual overview
This manual outlines how to use ClusterSeer, BioMedware’s tool for detecting
pattern in event data.
The first ClusterSeer manual presents the conceptual background for the
software, provides an overview of how to use ClusterSeer, and describes
10 cluster detection methods. The second ClusterSeer manual is a continuation and expansion of the first. Chapter 16-What’s New in ClusterSeer 2outlines the new methods, concepts and features in the software. Chapters
17-31 describe the 15 new statistical methods.
The manual also has a resources section that includes a glossary, references, and an index.
For easier differentiation of interface and description, this manual will use
the following style conventions:
Typeface

Meaning

serif type

explanatory text

sans serif type

part of the ClusterSeer interface,
such as menu items or dialogs

This information is also available in online help accessible from the
the “Help” menu and the “Help” buttons on dialogs in ClusterSeer.
The online help has hyperlinks that connect related topics.
BioMedware also has ClusterSeer Online Help on its website, www.biomedware.com/?module=Page&sID=clusterseer-help-and-tutorials. Please check
this for updates and additional information.
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CHAPTER 16

What’s New in
ClusterSeer 2

ClusterSeer provides data visualization tools and state-of-the-art statistical
methods to explore spatial and temporal patterns of disease and other events.
ClusterSeer now offers 15 new methods to investigate event clusters in space,
in time, or spatial clusters that depend on time (spatio-temporal interaction).
ClusterSeer also includes 4 new statistical concepts and 8 new features. This
chapter details these new methods, concepts and features.

ClusterSeer User Guide 2
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New methods
New
Methods

Cuzick &
Edwards’
Method

Spatial
Clustering

Temporal
Clustering

Global

Single

Multiple





Local



Dat’s Method



Direction
Method


Ederer-MyersMantel Method
Empty Cells
Method











Getis-Ord Local
G Method
Grimson’s
Method

SpatioTemporal
Clustering





Jacquez’s k Nearest Neighbor
Method



Knox Method




Kulldorff ’s Scan
Method



Larsen’s Method




Mantel’s Method
Moran’s I
Method



Oden’s I (Pop)
Method



Scan Method
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New concepts

•
•
•
•

Nearest in space
Nearest in time
Randomization types
Statistical distance test statistic

New features

•
•
•
•
•
•
•
•
•
•

Save project sessions
Export maps, histograms, and plots as bitmaps
Export histograms and plot data as DBF files
Export mapped results as a shapefile
Load in spatial features
Restart session
Legend pane for maps
Shapefile requirements
Import DBF files
Import temporal data formats more easily
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Methods for Detecting Global Spatial
Clusters
Global cluster detection methods are used to investigate the presence of spatial patterns
anywhere within the study area. They attempt to answer the question: Are there any
unusual spatial patterns? These focus on whether clustering exists or not, regardless of
location or scope. Essentially, these methods evaluate whether a spatial pattern exists in
the data that is unlikely to have arisen by chance. The null hypothesis for these methods
is simply “no clustering exists.”

Individual-Level Data

Group-Level Data

Cuzick & Edwards

Besag and Newell’s Method

Ripley’s K-function

Moran’s I
Oden’s Ipop
Grimson’s Method

Grimson’s Method can be used with either individual or group level data. For surveillance of spatial data, use Rogerson’s Method.
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Methods for Detecting Local Spatial
Clusters
These cluster detection methods are used to investigate spatial clusters in a particular
area. They can be thought of as methods that attempt to answer the question: Are cases
neighboring a particular case closer together than expected by chance?
Local cluster detection methods are available for group-level data only.

•
•
•
•
•

Besag and Newell’s Method
Turnbull’s Method
Anselin’s Local Moran
Getis-Ord Local G Test
Kulldorff ’s Spatial Scan Test

For surveillance of spatial data, use Rogerson’s Method.
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Methods for Detecting Temporal Clusters
Temporal cluster detection methods are used to investigate whether events (such as cases
of disease) tend to aggregate in particular time periods. All are used on group-level data,
though Grimson’s method can be used on individual-level data as well. These methods
can be used to evaluate disease frequency or case counts in a single or in multiple time
series.

Method

Disease or
event
frequency

Dat’s Method

Case or
event
count,
single
time
series

Case or
event
count,
multiple
time
series






Ederer-MyersMantel Method
Empty Cells
Method
Grimson’s Method
Larsen’s Method
















Levin & Kline’s
Modified CuSum
Wallenstein’s Scan

Case or
event &
population
-at-risk
counts





Grimson’s method will analyze spatio-temporal data, similar to multiple time series data.
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Methods for Detecting Space-Time
Clusters
Spatio-Temporal methods detect event clusters in space that depend on the time period
(Space-Time interaction).
Individual-Level data

Group-level data

Direction Method

Kulldorff ’s Spatio-Temporal
Scan

Jacquez’s k-Nearest Neighbor
Method

Grimson’s Method

Knox’s Method
Mantel’s Method
Grimson’s Method
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Methods that Adjust for Population
Several ClusterSeer methods adjust for population, because the population size can
influence the likelihood of events such as disease transmission. There are three subgroups of methods that account for population in different ways. The first group of
methods requires the user to submit disease or event frequency data. The second group
requires case or event count and population-at-risk data to be submitted in separate columns. The third group, a case-control group, requires users to judiciously select controls
from the same population as the cases. The table below shows which methods fall into
each of these population adjustment categories.
Method

Means of Adjusting for Population

Disease or
event
Frequency
Anselin’s Local Moran
Method

Case or event
and population at risk
count

Controls must
represent the
population at
risk



Besag & Newell’s Method



Bithell’s Method



Cuzick & Edwards’
Method



Diggle’s Method



Getis-Ord Local G Method



Kulldorff ’s Scan Method



Levin & Kline’s Modified
CuSum



Moran’s I Method



Oden’s IPop Method



Rogerson’s Method



Score Test



Turnbull’s Method
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Concepts: Nearest in Space
Nearest neighbor relationships are part of methods such as Cuzick and Edwards’ and
Jacquez's k-Nearest Neighbor (k-NN) methods. These methods consider whether events
neighbor each other in space or in space and time, respectively. Considering nearest
neighbors avoids the problem of setting a threshold distance to evaluate whether cases
are near or far from each other. Threshold distances are used in other methods, but may
not be appropriate to all datasets. For example, if your dataset consists of both urban and
rural locations, distances to neighbors will be longer in the rural locations than in the
urban region. Thus, no single threshold distance will capture the types of neighborhoods
you wish to consider.

Spatial nearest neighbors
ClusterSeer calculates nearest neighbor relationships from the distance between events
submitted as a file of point locations (as occurs in the Cuzick & Edwards' method).
Nearest neighbor relationships in space may or may not be reciprocal. A point could be
its nearest neighbor's nearest neighbor, but perhaps its nearest neighbor is actually closer
to something else. In the figure below, the asterisks are nearest to each other but the #'s
nearest neighbor is a 1.
#

*

*

k-NN
A point has a nearest neighbor, but nearest neighbor relationships can be considered at
higher levels. The nearest neighbor methods in ClusterSeer are flexible and can consider
several levels of neighbors (first nearest neighbor, first and second nearest neighbor,
etc.). k defines the number of neighbors to consider in the analysis. In the illustration
below, the # has both asterisks as its first and second nearest neighbors (k = 2).
2
#
1
*

*

163

What’s New in ClusterSeer 2

Ties
A problem with nearest neighbor methods is how to resolve ties. If two neighbors are
the same distance from the event considered, which one should be scored? ClusterSeer
solves the tie arbitrarily by choosing only one of the tied events.

Concepts: Nearest in Time
Nearest neighbor in time relationships are part Jacquez's k-Nearest Neighbor (k-NN)
method.

Temporal nearest neighbors
Jacquez's k-NN method considers temporal adjacency to evaluate clustering. It categorizes whether events neighbor each other in space and time. ClusterSeer calculates nearest neighbor relationships in time by placing the events in a dataset in chronological
order. The nearest neighbor of an event is the prior event, as illustrated in the diagram
below. Because the nearest neighbor is always the prior event, nearest neighbor relationships in time are never reciprocal, unlike spatial nearest neighbors.

1

2

3

4

5

6

k-NN
A point has a nearest neighbor, but nearest neighbor relationships can be considered at
higher levels. The nearest neighbor methods in ClusterSeer are flexible and can consider
several levels of neighbors (first nearest neighbor, first and second nearest neighbor,
etc.). k defines the number of neighbors to consider in the analysis. In the illustration
below, 4 & 5 are the two nearest neighbors of 6.
1
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2

3

4

5

6

Concepts: Nearest in Time

Ties
A problem with nearest neighbor methods is how to resolve ties. If two neighbors are the
same time from the event considered, which one should be scored? A problem with
nearest neighbor methods is how to resolve ties. If two neighbors are the same distance
from the event considered, which one should be scored? ClusterSeer solves the tie arbitrarily by choosing only one of the tied events.
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Concepts: Types of Spatial
Randomization
Monte Carlo randomization is one way to quantitatively evaluate observed data and test
statistics. See the first ClusterSeer manual (p.20) for details on procedures for calculating
Monte Carlo P-values. Within ClusterSeer, spatial randomization techniques vary among
methods. For the multinomial and Poisson distributions, ClusterSeer generates random
values by choosing values from the specified distribution. For conditional randomness,
data values are reassigned among sub-groups.

Randomization Technique

Drawing from a multinomial distribution

Drawing from a Poisson distribution

Cluster Detection
Method

•
•
•
•
•
•
•

Besag and Newell's
Bithell-conditional
Kulldorff's Scan
Oden's Ipop
Turnbull’s
Bithell-unconditional
Score

Conditional randomness

• Local Moran

Randomize data (rate, count, or case-control
label) among spatial locations by swapping labels

• Cuzick and Edwards'
method

• Getis-Ord Local G
• Moran's I
Alter distances between points by multiplying
their locations by a random number
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Concepts: Types of Temporal
Randomization
Within ClusterSeer, temporal randomization techniques and distribution theory vary
among methods. For Poisson distributions, ClusterSeer generates random values by
choosing values from the specified distribution.

Randomization or Distribution Technique

Cluster Detection
Method

These methods assume the cases are allocated with
equal probability across the time cells. They each take n
cases and distribute them at random among t time cell
intervals. Unlike multinomial randomization techniques,
these temporal methods have no population base information: thus, the probability of a case being placed in a
particular time interval is not proportional to the population-at-risk size in that interval.

• Dat's method
• Ederer-Myers-

Drawing from a Poisson distribution

• CuSum
• Grimson's method

Drawing from the Normal distribution

• Grimson's method

Mantel

• Empty Cells
• Larsen's method
• Scan method
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Concepts: Types of Space-Time
Randomization
Randomization Technique

Cluster Detection
Method

Shuffling time distances or adjacencies

• Jacquez’s k-NN
• Knox
• Mantel

Shuffling time of occurrence of cases
across case locations

• Direction

For the Knox, K-NN, and Mantel methods, ClusterSeer randomizes the space-time
relationships by shuffling the time distances between cases or events while holding the
spatial distances constant. The statistics are then recalculated on the randomized
datasets. The null hypothesis for each of these tests is that there is no significant relationship between the spatial and temporal distances, so that breaking them should be no
problem. If there is significant space-time association in the dataset, the random shuffling of the times will tend to produce datasets with less space-time association, and the
observed value will be significant when compared to the randomizations.
For the Direction method, the significance of the average direction is evaluated
through a randomization procedure which holds the sine and cosine matrices constant
and randomly assigns connections between pairs of cases. This is equivalent to holding
the locations of the cases fixed while randomizing their times of occurrence. This randomization procedure is repeated to generate a distribution of the angular concentration
under the null hypothesis. A P-value is determined by comparing the angular concentration from the original (not randomized) data to this null distribution.
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Concepts: Statistical Distance Test
Statistic
This statistic is used to evaluate the significance of multiple sets of Monte Carlo simulations in Jacquez's k-Nearest Neighbor and Cuzick & Edwards’ methods.
It combines the P-values across the number of tests you specify (k). Similar to the Bonferroni and Simes combined P-values, this statistic gives an overall probability that
accounts for multiple comparisons. With this measurement, you can calculate the distance between the mean of a cluster Ji1 and a single data point, i.
Allow J to signify a 1 X 10 vector of the test statistics (J1,…J10) (You can substitute Tk
for J). For each randomization ClusterSeer computes a J vector, which can be represented as a location in 10 dimensions. The results under randomization form a cloud of
“Number of runs” points in this 10-D space. The center of the cloud is the centroid. You
can evaluate significance by comparing the statistical distance from the centroid of the
observed vector J to the statistical distances from the centroid of the J vectors being randomized. The statistical distance from each point to the centroid is as follows:

di =

( J i1 – J i1 )
( J i10 – J i10 )
------------------------ + … + ----------------------------s1
s 10

Here di is the distance from point i to the centroid. Ji1 is the value of the statistic, and Jk
calculated for k=1 using the data from the first randomization. s1 signifies the standard
deviation of the J1 under randomization, and J 1 is the mean of J1.
ClusterSeer calculates an upper-tail P-value based on the Monte Carlo simulations,
counting the number of distances to the centroid that are greater than or equal to the distance from the observed J to the centroid. This P-value is the probability, under the null
hypothesis, of observing a vector of Jk or ( ∆ Jk) as or more extreme than the observed. If
the combined P-value is smaller than 0.05, you can reject the null hypothesis that there is
no spatial clustering.
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New Features
Save your project session
You may save your work as a project to reopen in a later ClusterSeer session. The project
file (*.csr) includes the session log, and any corresponding maps and plots you created, as
long as the plots were generated without using Monte Carlo Randomization techniques.
Note: ClusterSeer does not save the histograms or plots created from Monte Carlo runs.
However, you can export them to a bitmap or DBF format and view them that way. You
can also run the analysis again to see the new histogram and plot, but because of the randomizations the outcomes may be slightly different from the original.

Export images
After performing a statistical analysis, you may export plots, maps, and histograms as
images. to a bitmap, DBF, or Shapefile format. ClusterSeer allows you to export only
those items that each statistical method includes in its output. The session log can be
exported as a text file only.
1.

Choose Export from the File menu.

2.

Select the item you want to export (histogram, map, or plot) and choose the Bitmap
format.

3.

If you wish, you can change the default name of the file and where it will be saved.
Then hit Save as. You can then open this image in any software program that
accepts bitmap format files (*.bmp). You can also use an image processing program
that can convert bitmaps to different formats.

Export histogram and plot data
You can also export statistical results as DBF files that can be imported into spreadsheet
programs for further graphical refinement or statistical exploration.
1.

Choose Export from the File menu.

2.

Select the item you want to export (histogram or plot) and choose DBF format.

3.

If you wish, you can change the default name of the file and where it will be saved.
Then hit Save as.
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You can then open this file in any software program that accepts DBF files (*.dbf).

Export mapped results as a shapefile
You can also export mapped results as shapefile that can be imported into a GIS program to layer with other data. ClusterSeer does not re-export data you brought in to the
system, only data that result from analyses in the software.
See the table below to learn what types of information can be exported from which of
the methods. For those methods that produce no mapped results (such as many global
clustering methods) the only way to export the map is as an image.
1.

Choose Export from the File menu.

2.

Select map and choose shapefile format

3.

Specify the coordinate system you want to use. This option is only available if you
brought in geographic data (latitude-longitude decimal degrees). Otherwise, the
results will be saved out in the same planar projection of your original dataset.

4.

If you wish, you can change the default name of the file and where it will be saved.
You must use a different name than your original data if you do not intend to overwrite it. Then hit Save as.

You can then open these file in any software program that accepts shapefiles.
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Mapped results

Methods

Exported

Circular cluster outlines

Besag & Newell’s

Shapefile containing circular polygons that
describe the cluster
extent.

Kulldorff ’s Scan
Local G
Turnbull’s
New variables for areas/
polygons

Local Moran

A new polygon shapefile
with the single variable
you chose to import and
the new variables as added
columns. Do not overwrite your original dataset,
as you will lose any other
columns from that file.

Space-time interaction
lines between point
locations

Direction

Shapefile containing lines
that connect point locations (one set of lines for
Direction, three types for
Knox)

No mapped results
(map only shows original data)

All other spatial, spacetime, temporal, and surveillance methods.

Knox’s

No data exported. You
can export a bitmap image
of the mapped data.

Load in spatial features
Spatial features are vector files that contain locations or spatial information to help visualize spatial data and results. ClusterSeer can accept points as text or shapefiles or polygon shapefiles for use as spatial features. No data aside from the spatial boundaries or
locations is imported.
For instance, if you are analyzing disease rates assigned to county centroids, you may
wish to bring in a feature of the county boundaries so that you audience can more easily
recognize the area’s geography.
To load in a spatial feature, choose Import Spatial Feature from the View menu.
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Restart session
If you wish to start your ClusterSeer session from scratch, you can choose Restart
session from the File menu.
This clears the Session Log of the summaries of actions previously performed by ClusterSeer and any notes you have added. It also closes any open maps, plots, or histograms
from the previous analysis.

Legend pane for maps
Most ClusterSeer maps are displayed in a three-pane window. The left-hand pane lists the
active layers in the map, the middle pane contains the map itself, and the right-hand pane
is the map legend. This legend pane is new in ClusterSeer version 2.
The right panel identifies the symbols for active map layers. You may need to expand the
frame to view the full legend names. Displayed legend items are often color-coded to
match the layers.

Shapefile requirements
ClusterSeer 1 could take shapefiles for some of the methods. Now, it accepts shapefiles
as the main data format for all spatial methods.
ClusterSeer will send you an error message if your data do not meet its shapefile requirements. Make sure to prepare your data with a GIS data editor so that it does not contain
self-intersecting polygons. A polygon is called "self-intersecting" when two or more of its
borders intersect anywhere except their endpoints.
If your polygons overlap, it may be difficult to view them when mapped or to select them
for queries. ClusterSeer will not be able to display properly shaded areas where overlap
occurs. Uniquely named polygons completely contained within another polygon will be
correctly processed for analysis and display. Relatively smaller, non-uniquely named polygons will be discarded on import and excluded from the analysis.

Import DBF files
With ClusterSeer, you can now import DBF files for all methods except Moran's I, Local
Moran, Oden's Ipop, and Grimson's.
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• For spatial and spatio-temporal methods, when you import a DBF file, ClusterSeer
will prompt you to select which columns in the data file hold the relevant information. You must include labels when importing DBF files into ClusterSeer.

• For temporal methods with a single or multiple time series, your first column must
contain the label, and subsequent columns should contain your case count data. You
must include labels when importing DBF files into ClusterSeer. Modified CuSum is
currently the only method that does not require a label.
You may keep track of your columns by labeling them in the first row of your dataset.
The labels are separate from the first column of ID labels, and will not interfere with
ClusterSeer's analysis.

Temporal data formats
ClusterSeer 2 has relaxed its temporal data format requirements from what is described
in the first ClusterSeer User Guide. Now there are two format options for all calendarbased time intervals (see format options 1 & 2 in the table below).
For the years, you can omit the first two numbers of the date for any date in the 1900s.
Thus, if you use "89" for example, ClusterSeer will assume that the preceding numbers
were "19" or "1989." You can use dates with two and four numbers in the same file as
long as the dates other than those in the 1900s have four digits.
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Sample
data

Format
Option
1
(with
example)

Format
Option 2
(with
example)

Yearly

YYYY

YY

(1998)

(98)

YYYYMM

YYMM

(199801)

(9801)

YYYYWW

YYWW

(199843)

(9843)

MM/DD/
YYYY

MM/DD/
YY

(1/2/1998)

(1/2/98)

Monthly
Weekly

Daily

Notes

Valid
Range

01 to 9999
monthly values (MM)
range from 01-12

0101 to
999912

weekly values (WW)
range from 01-52

0101 to
999952

month and date values may be expressed
as single digits

12/30/1899 to
12/31/9999
or
12/30/00 to
12/31/99

Userdefined

Userdefined

Userdefined

(5)

(5)

Positive whole numbers that may represent points in time or
non-overlapping,
successive temporal
intervals. In this
scale, the intervals are
naturally ordered by
their magnitude (5
comes after 4) and
there is a known unit
distance between any
2 successive numbers.

0 to 4.2 billion
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CHAPTER 17

Cuzick & Edwards’
Method

Cuzick & Edwards’ method (Cuzick & Edwards 1990) can detect global spatial clusters in individual-level case-control data. This method uses the control location to reflect the geographic variation in the population density as a
whole. Use this method when you know both case and control locations (e.g.
place of residence), and when you have selected controls from the same population as the cases. You should code your cases 1 and your controls 0.

Examples
Dockerty et al.(1999) used Cuzick and Edwards’ method to analyze clustering
in leukemias and lymphomas among young people in New Zealand, a country without nuclear installations. They found that there was no statistically
significant spatial clustering in any of the leukemias or lymphomas tested.
Doherr et al.(1999) found significant spatial clustering of Cornyebacterium
pseudotuburculosis in horses using Cuzick and Edwards’ method. They used
information on spatial clustering to infer transmission patterns of the infection.
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Cuzick and Edwards' Method: Statistic
Ho

Cases & controls are sampled from a common spatial point distribution.

Ha

The cases are spatially clustered relative to the controls.

For this method, ClusterSeer quantifies nearest neighbor relationships between individuals to determine whether clustering exists in the dataset.

Test statistic
The test statistic, Tk, counts how many cases neighbor other cases. You can define a
number of different sizes of "neighborhoods" or spatial scales by specifying k, which
indicates the number of nearest neighbors to consider in the analysis. ClusterSeer calculates the number of k nearest neighbors to each case that are also cases. Tk is the total
over all cases in the dataset. For example, T1 is the number of cases in the dataset neighbors are also cases (k=1).

N

Tk =

∑

δi di

k

i=1
Where:

• N: the sample population size
• N0: the number of cases
• N1: the number of controls
• δi = 1 if observation i is a case and 0 if it is a control.
• d ki = 1 if the kth nearest neighbor to i is a case, 0 otherwise.
The expected value of the test statistic under the null hypothesis is
E ( T k ) = pkN
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In this equation,

N N0 – 1 
p = -----0-  --------------NN–1
The z-score is calculated as:

T k – E ( Tk )
------------------------z =
Var ( T k )
The z-score calculates a standardized difference between the observed Tk and expected
E(Tk) values of a statistic divided by the standard deviation. For more information about
z-scores, see the first ClusterSeer User Guide, p. 19.

179

Cuzick & Edwards’ Method

Cuzick & Edwards’ Method: Significance
ClusterSeer provides several ways to evaluate the significance of the test statistic (Tk).

• ClusterSeer provides the upper-tail P-value, which is the probability under the null
hypothesis of observing a Tk as large or larger than the one given in Tk. It is based on
the assumption of a normal distribution of the data.

• ClusterSeer also generates P-values via the Monte Carlo simulations for each k. ClusterSeer randomizes the data by shuffling the case-control labels for each of the spatial
locations. This is a way to compare the observed Tk to the distribution of Tk based
on a random distribution of the data.

Multiple comparisons analysis
When k>1, the method calculates a statistic at each value of k. This is multiple testing.
ClusterSeer automatically runs a multiple comparisons analysis to determine the proper
significance level for all comparisons. ClusterSeer provides a combined P-value for all
tests performed at one initial alpha level. This is accomplished through Bonferroni and
Simes adjustments.

• Bonferroni P c = j [ min ( P i ) ]
• Simes P c = min ( n + 1 – i )P i
In this case, Pc denotes the combined P-value for all tests, Pi the value for an individual
test, j is the number of comparisons, and i is the sequential index for the individual test
considered. You can compare this value to your original alpha level to see if the tests
show significant results.
This topic is related to the combined P-values feature available in multiple comparisons
for other methods, but it uses Simes' formula instead of Holm's.

180

Cuzick and Edwards’ Method: How To

Cuzick and Edwards’ Method: How To
Choose Cuzick & Edwards’ method from the Analysis menu. (Spatial|Global submenus).
In a series of dialogs, ClusterSeer will prompt you to submit the file to analyze. If you
submitted a suitable dataset in the previous analysis, you will jump directly to the Choose
settings step listed below.

Submit data file
1.

ClusterSeer will prompt you to submit the data file (text file, DBF, or point shapefile).
If you submit a text file with header, DBF, or shapefile, ClusterSeer will prompt you
to identify which columns in your file contain the required data. In this case, the columns can be in any order
If it is a text file without a header, it should contain individual-level data with the following columns in the following order.
Subject label
(optional)

Point x-coordinate
(not for shapefile)

Point y-coordinate
(not for shapefile)

Case/control status

2.

You will need to specify the coordinate system of the data. If the data are in geographic coordinates, you will also need to choose a distance measurement.

3.

If your data file includes labels, choose Selected data file contains label. If
your dataset has no column of labels, select Use study row # as label.

Choose settings
4.

In the Provide data dialog, you may use the Select File button to change your
file choices.

5.

Enter the maximum number of nearest neighbors to analyze for clustering. The size
of the cluster you choose to detect (k) determines in part where you can detect significant clusters. The value you choose to enter should be based on information about
the disease process.

6.

Choose the number of Monte Carlo runs, the number of simulations used to determine statistical significance of the test statistic. The default value is 999.

7.

Enter the significance level you wish to use for the test. The significance level is the
alpha level, the cutoff for statistical significance. The default value is 0.05.
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Run the analysis
8.

After you hit OK, ClusterSeer will establish nearest neighbor relationships. If you hit
Stop at this point, the procedure will cancel.

9.

Then, ClusterSeer will run the Monte Carlo simulation. You may stop the simulations
at any time using the Stop button on the progress bar. The stop button will halt the
simulations and the results will be displayed for the number of Monte Carlo runs
completed by the time you pressed the button.
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Cuzick & Edwards’ Method: Results
Distribution
You can view the Monte Carlo distribution by choosing MC Distribution from the
View menu.
The histogram shows the reference distribution generated by randomizing the dataset
and recalculating Tk. Select k, the number of nearest neighbors you would like to see in
the distribution. Tk is illustrated in red, and it is compared with the distribution for estimating the one-sided P-value.

Map
You can view the map by choosing Map from the View menu. The map has one layer
that shows case-control points.
It can be queried to show the x- and y-coordinates of the point, the subject label
and case-control status. You may use the zoom function to magnify the points.

Plot
Choose Plot from the View menu. You can view a plot of P-values simulated from
Monte Carlo runs. Using the plot may help you to determine the minimum number of
Monte Carlo runs to perform in your analysis. The simulated P-value plot shows how the
significance of the test statistic changes with the number of Monte Carlo randomizations
performed.
What you will usually see is that the P-value decreases from near p=1.0 to an asymptote
before it reaches the number of randomizations you specified in the analysis. If it
decreases to the asymptote after few randomizations, you specified a greater number of
randomizations than was required to find the P-value. If it continues to fluctuate, you
may wish to rerun the analysis with a greater number of randomizations to find the Pvalue.
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Session log
After ClusterSeer performs a Cuzick and Edwards analysis, it will place summary information and results into the session log.
Parameters and summary statistics

• k, the number of nearest neighbors
• The Test statistic, Tk, counts how many cases neighbor other cases.
• The expected value of the test statistic E(Tk) under the null hypothesis
• The variance of Tk under the null is a fairly complex expression and is given in Cuzick and Edwards (1990). The variance describes the amount of variability of your data
around the mean value.

• Z-scores
• Upper-tail P-value: the probability under the null hypothesis of observing a Tk as
large or larger than the one given in Tk, based on a normal distribution of the data.

• Monte Carlo P-values
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Combined P-values

• Bonferroni and Simes corrected P-values for the normal approximation, and for the
Monte Carlo Distribution: See “Multiple comparisons analysis” on page 180.

• Statistical Distance Test statistic and its P-value: Refer to “Concepts: Statistical Distance Test Statistic” on page 169.
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CHAPTER 18

Dat’s Method

Dat's 0-1 Matrix Test (Dat 1982) can detect temporal clustering in single and
several time series with group-level data. Use Dat's method with counts, not
rates, on 5-10 time intervals. Within a time series the method assumes population size does not change through time.
You cannot use Dat's method when the expected number of cases in each
interval is smaller than 2. This means the total number of cases in the time
series must be greater than twice the number of time intervals. Otherwise,
consider using the Empty Cells method. See “Empty Cells Method ” on
page 211. If 11 or more time intervals are present you may be able to aggregate data by combining time intervals.
Dat's method is more sensitive than the Ederer-Myers-Mantel method in
detecting multiple clusters within a space sub-unit.
ClusterSeer’s temporal methods do not analyze space-time interactions. If
you have data pertaining to spatial location, you may want to consider running one of ClusterSeer’s Spatio-temporal cluster detection methods. See
“Methods for Detecting Space-Time Clusters” on page 161.
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Dat’s Method: Statistic
Ho

Cases occur at random over the t time periods.

Ha

Cases do not occur randomly through time.

ClusterSeer provides two tests for temporal clustering under Dat's method: within a single time series (using the z-score) and across several time series simultaneously (using the
Chi-squared statistic).
The test statistic, A, is the number of cells containing more than the number of cases
expected in the absence of clustering. A large test statistic indicates cluster avoidance
such that some of the time intervals have slightly more than the expected number of
cases. The test statistic is small when cases cluster in a few time intervals.
n
A: The test statistic is the number of time intervals with at least --- – 0.5 cases.
t

Where:

• t: Number of time intervals
• n: Total number of cases observed over t
•

n
--- : Number of cases expected in an interval in the absence of time clustering
t

•

x : The least integer greater than x. For example, 1.3

= 2.

According to the null hypothesis, the n cases are distributed at random across the t time
intervals. Under this null hypothesis the expectation and variance are:

d

=

n
--- –
t

n
--- – 0.5
t

E ( A ) = t ( 0.6 + 0.3 d )
V a r ( A ) = 0.155 E ( A )
Significance
A z-score is calculated as:
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z

=

A – E(A )
---------------------------- , z ∼ N ( 0, 1 )
Var(A)

The approximate distribution of z is normal with a mean of 0 and unit variance. P-values
are evaluated by comparing z to the percentiles of the normal distribution.
When analyzing several time series simultaneously an overall P-value is obtained as a Chisquared statistic with one degree of freedom:

2

s
s



Ai –
E ( A i ) – 0.5


 i = 1

i = 1
------------------------------------------------------------------------------------------

∑

χ

2

=

∑

s

∑

V a r ( Ai )

i = 1
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Dat’s Method: How to
Choose Dat’s method from the Analysis menu. (Temporal|Single or Several
time series submenus).
In a series of dialogs, ClusterSeer will prompt you to submit the file to analyze. If you
submitted a suitable dataset in the previous analysis, you will jump directly to the
Choose settings step listed below.

Submit data file
1.

ClusterSeer will prompt you to submit the data file (text or DBF).
If the text file does not include a label, ClusterSeer will use the row number as the
label, which assumes that the sequence of case counts in the file increases with the
row number. The DBF file must include a label.
Your file should contain group-level data with the following columns in the following
order:

For single time series:
Time Sequence Label

Case Count

(required for DBF files only)

For several time series:

2.

Region Label

Case Count

Case Count

Case Count

(required for
DBF files only)

Time 1

Time 2

Time 3

...

If your data file includes labels, choose Selected data file contains label. If
your data have no labels, select Use study row # as label.

Choose settings
3.

In the Provide data dialog, you may use the Select File button to change your
file choices.

4.

Enter the number of time series in your dataset. For a single time series, enter 1. For
several time series, enter the total number of locations where you collected data for
consecutive intervals of equal length.
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Run the analysis
5.

After you hit OK, ClusterSeer will establish nearest neighbor relationships. If you hit
Stop at this point, the procedure will cancel.

6.

Then, ClusterSeer will run the Monte Carlo simulation. You may stop the simulations
at any time using the Stop button on the progress bar. The stop button will halt the
simulations and the results will be displayed for the number of Monte Carlo runs
completed by the time you pressed the button.
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Dat’s Method: Results
Plot
To view the plot, choose Plot from the View menu.
ClusterSeer will plot the observed statistic A on its expectation E(A) for a single and/or
several time series. This plot describes where observations would be plotted under the
null hypothesis of cases occurring at random over the t time periods. The time series are
the red points on the graph. The blue line is the identity function (observed=expectation) describing where observations would be plotted under the null hypothesis. Under
cluster avoidance A> E(A), and the time series plot above the 45 degree line. When time
clustering exists, A< E(A), and time series plot below the line.

Session log
Once ClusterSeer has performed a Dat's analysis, it will place summary information and
results into the session log.
Data and analysis input

•
•
•
•

Data sets used
Number of time series
Number of cells per series
The test statistic A, is the number of cells containing more than the number of cases
expected in the absence of clustering.

Results
ClusterSeer reports the results of the analysis for the single and several time series for
each row in the time series:

•
•
•
•

The expected value of A: (E(A))
Its variance: (Var (A))
Z-score
Upper-tail P-value: The upper-tail P-value is the probability under the null hypothesis
of observing an A as large or larger than the one given in A. It is based on a normal
distribution of the data.
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For several time series, ClusterSeer also provides:

• A Chi-squared statistic
• An overall P-value
• A list of time series it was unable to analyze.
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CHAPTER 19

Direction Method

The Direction method (Jacquez and Oden 1994) tests for space-time interaction of retrospective, individual level data, and calculates the average direction of advance of a spread of cases. The method is sensitive to a systematic,
directional spread of cases, such as occurs when an epidemic sweeps through
an area. It also arises from geographically localized exposures, with individuals near the source receiving higher doses and showing symptoms before
those farther from the source.
You cannot infer a directional process from the Direction method; you can,
however, determine whether the observed spread of cases tends to be in one
direction.
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Direction Method: Statistic
Ho

Ha

No association exists between the times at which cases occur and
the directions of the vectors formed by connecting the spatial locations of the case.
The direction from one case to the next is similar for cases that
occur at about the same time.

A chain of infection is constructed by first sequencing the cases by time of occurrence.
The earliest case would be first, followed by the second case and so on. A line is then
drawn to connect the location of the first case to the location of the second case, and this
is repeated until all cases are connected. The chain of infection has at least two ends (the
first and last cases), and branches when cases occur at exactly the same time.
The test statistic is a vector whose direction is the average direction of the lines composing the chain of infection, and whose magnitude is the angular variance of these marks.
When the marks all point in the same direction, the angular variance is small, and when
they point in many directions the angular variance is large.
The test statistic is a vector V pointing in the average direction of advance of the chain
of infection:

1
c
v = ---- T ⊗  -- 
m
s
Where:

• c: Cosine matrix whose elements are cij;
• s: Sine matrix whose elements are sij;
• T: Time connection matrix describing the proximity, in time, of the cases to one
another.
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∆x ij

• c ij = cos ( Θ ij ) = -----------------------------------

2
2
 ∆x ij + ∆y ij 
∆y ij
• s ij = sin ( Θ ij ) = ----------------------------------2
2
∆x ij + ∆y ij
• (xi, yi,): Geographic coordinates of case i.
• ∆x ij : Distance on x axis between cases i and j, ∆x ij = ( x i – x j )
• ∆y ij : Distance on y axis between cases i and j, ∆y ij = ( y i – y j )
• Θ ij : Angle between a horizontal line and the vector connecting areas i and j
The vector v points in the average direction of advance of the spread of cases, and its
magnitude (termed the angular concentration) represents the variance in the angles
between connected cases. When the magnitude is small the variance in the angles is large,
and when the magnitude is large the variance in the angles is small. Angles are taken as
counter clockwise degrees from horizontal, with East corresponding to 0 and North to
90. Concentration is in the range of 0 to 1, with 1 indicating an angular variance of 0. A
consistent direction of spread of cases will result in an angular concentration near 1. A
random spread of cases will result in an angular concentration near 0.
The elements of the time connection matrix are determined by the researcher to reflect
the suspected temporal scale of the pattern.
ClusterSeer calculates significance values to help you evaluate the significance of the test
statistic.
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Direction Method: How to
Choose Direction method from the Analysis menu. (Spatio-temporal submenu).
In a series of dialogs, ClusterSeer will prompt you to submit the file to analyze. If you
submitted a suitable dataset in the previous analysis, you will jump directly to the Choose
settings step listed below.

Submit data file
1.

ClusterSeer will prompt you to submit the data file (text, DBF, or point shapefile).
If you submit a text file with a header, a DBF, or a shapefile, ClusterSeer will prompt
you to identify which columns in your file contain the required data. In this case, the
columns can be in any order.
If you wish to submit a text file without a header, it should contain individual-level
data with the following columns in the following order.

Space-Time Case File:
case level
(optional)

case event xcoordinate (not
for shapefile)

case event ycoordinate (not
for shapefile)

case event timepoint (user
defined integer)

2.

You will need to specify the coordinate system of the data. If the data are in geographic coordinates, you will also need to choose a distance measurement.

3.

If your data file includes labels, choose Selected data file contains label. If
your data have no labels, select Use study row # as label.

Choose settings
4.

In the Provide data dialog, you may use the Select File button to change your
file choices.

5.

Enter the time connection matrix specification. Suppose N cases occur at times (t1tN). The elements of the time connection matrix are determined by the researcher to
reflect the suspected temporal scale of the pattern. See “Alternative directed time
measures” on page 200.
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Run the analysis
6.

After you hit OK, ClusterSeer will establish nearest neighbor relationships. If you hit
Stop at this point, the procedure will cancel.

7.

Then, ClusterSeer will run the Monte Carlo simulation. You may stop the simulations
at any time using the Stop button on the progress bar. The stop button will halt the
simulations and the results will be displayed for the number of Monte Carlo runs
completed by the time you pressed the button.
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Alternative directed time measures
Use relative when you wish to include vectors connecting each case to all of the cases that
follow it. This is appropriate when you hypothesize a directional process operating on a
longer time span. You are connecting cases that may be several links removed from the
chain of infection.
Relative: t

ij = 1

if

t j > t i ; t ij = 0 if t j = t i ; t ij = – 1 if t j < t i

Use adjacent when you wish to connect each case only to its temporal nearest neighbors.
These are the cases that occur just before and just after the case. This is appropriate
when you hypothesize directional effects of short duration.

t ij = 1 if t j
t ij = 0 otherwise

Adjacent:

is just after

t i ; t ij = – 1 if t j

is just before

ti ;

Use following when you wish to connect each case only to the case (or cases) that immediately follow it. This is appropriate when you wish to trace the average direction of the
chain of infection.
Following:
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t ij = 1 if t j

is just after

t i ; t ij = 0

otherwise

Direction Method: Results

Direction Method: Results
Monte Carlo distribution
You can view the Monte Carlo distribution by choosing MC Distribution from the
View menu. The histogram shows the reference distribution generated by randomizing
the dataset and recalculating the observed value. The relative position of the observed
value of r is illustrated with a slim, vertical black line.

Map
You can view the map by choosing Map from the View menu. The map has one layer
that shows case-control points.
This map shows a chain of infection. The cases are the black dots, the green lines connect cases sequentially by time of occurrence, and the red lines show the spatial direction
of the spread of infection.

If you query one of these points, you can view its label, spatial coordinates, and its
time of occurrence.

Session log
After ClusterSeer performs a Direction analysis, it will place summary information and
results into the session log.
Parameters and summary statistics

• The file used
• The total number of cases analyzed
• Time measure used (Relative, Adjacent, or Following)
Direction Results

• The vector v, the average angle which points in the average direction of advance of
the spread of cases. An average angle will always be calculated, whether or not there is
a systematic direction to the spread of cases, and is meaningful only when the concentration is statistically significant.
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• The angular concentration is the magnitude of v and represents the variance in the
angles between connected cases.

• The P-value for the angular concentration
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CHAPTER 20

Ederer-Myers Mantel
Method

The Ederer-Myers-Mantel method (Ederer, Myers, and Mantel 1964) tests
for temporal clustering in several time series simultaneously (group level
data). Case counts in consecutive time periods for several areas are required.
The number of time intervals in the series must be between 2 and 5. The test
is insensitive to different population sizes over the areas. Therefore, the
method is biased by changes in population size through time.

Examples
Fosgate et al. (2002) studied temporal clustering in human brucellosis in California using the Ederer-Myers-Mantel method. They found significant clustering in Hispanic, non-Hispanic and total cases in different counties in
California and in several time periods in 1973-1992. Ward and Carpenter
(2000) used this method to evaluate temporal clustering in blowfly strike
infestation in Australian sheep flocks.
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Ederer-Myers-Mantel Method: Statistic
Ho

Cases occur at random in each time series.

Ha

Cases do not occur randomly through time; they either cluster or
occur uniformly.

The test statistic is m1, the maximum number of cases observed in any of a sequence of
time intervals. When cases are clustered m1 will be large; it will be small when cases occur
uniformly through time.
Notation:

• t: number of time intervals
• T: number of time intervals in the time series
• ri: number of cases in time series i
• f(r): frequency, over all time series, of a given number of total cases
• m1i: the largest number of cases in any time interval of time series i
ClusterSeer constructs a Chi-squared statistic table to test for time clustering in several
areas simultaneously. It calculates a Chi-squared test statistic and P-value for each of the
following: exact permutation, table values and simulated values.

2

 T

 T




m 1i – E
m 1i – 0.5







2
i=1
i=1
χ 1 = -------------------------------------------------------------------------------

∑

∑

T

∑ Var ( m1i )
i=1

204

Ederer-Myers-Mantel Method: Statistic

T

The summations are over the number of time intervals in the time series,

∑m

1i

is the

i=1



m 1i and
sum of the maximum number of cases over all time series, E 


i = 1 
T

∑

T

∑ Var( m

1i )

are sums of the expectation and variance of m1i under the null hypothesis.

i=1

ClusterSeer calculates several values: estimate and variance values for the exact permutation test, table values, simulated values and simulation P-values for each region in the
time series.
There are two ways the distribution of cases can differ from their null distribution: They
may cluster (m1 larger than expected) or they may be uniform (m1 smaller than expected).
Either of these alternatives will inflate the Chi-squared statistic. Use the plot of the
expected m1 on the observed m1 to determine the nature of the departure (if any) from
the null distribution.

Note

• You can request ClusterSeer to report exact values. This calculation may take some
time since the process grows exponentially with the number of time series and the
number of counts in each time series.

• Whenever possible, use the exact values. When exact values are not available and you
must choose between table and simulated values, use simulated, which are generally
the most accurate. The simulated and table values should resemble each other.

• Due to the fact that they are approximated, some of the table estimate and variance
values are interpolated. ClusterSeer places an asterisk next to the interpolated values
in the session log.
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Ederer-Myers-Mantel Method: How to
Choose Ederer-Myers-Mantel method from the Analysis menu. (Temporal|Several time series submenus).
In a series of dialogs, ClusterSeer will prompt you to submit the file to analyze. If you
submitted a suitable dataset in the previous analysis, you will jump directly to the
Choose settings step listed below.

Submit data file
1.

ClusterSeer will prompt you to submit the data file (text file or DBF).
If the data file does not include a label, ClusterSeer will use the row number as the
label, which assumes that the sequence of case counts in the file increases with the
row.
Your text file or DBF should contain group-level data with the following columns in
the following order:

For several time series:
Region Label

Case Count

Case Count

Case Count

(required for
DBF files only)

Time 1

Time 2

Time 3

...

Choose settings
2.

If your data file includes labels, choose Selected data file contains label. If
your data have no labels, select Use study row # as label.

3.

Enter the number of time series in your dataset. For a single time series, enter 1. For
several time series, enter the total number of locations where you collected data for
consecutive intervals of equal length.

4.

You may want to check the Calculate True Values Box. If you do, ClusterSeer
calculates the exact, rather than interpolated values for the estimate and variance of
m1, and the Chi-squared statistic and P-value. As the number of cases and time cells
increases, so does the time it takes to calculate these values. You may press “abort” to
stop the calculation process.
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Run the analysis
5.

After you hit OK, ClusterSeer will establish nearest neighbor relationships. If you hit
Stop at this point, the procedure will cancel.

6.

Then, ClusterSeer will run the Monte Carlo simulation. You may stop the simulations
at any time using the Stop button on the progress bar. The stop button will halt the
simulations and the results will be displayed for the number of Monte Carlo runs
completed by the time you pressed the button.
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Ederer-Myers-Mantel Method: Results
Plot
You can view the plot by choosing Plot from the View menu. The blue line is the identity function (m1- E(m1)) describing where observations would be plotted under the null
hypothesis. Time clustering causes m1 to be larger than its expectation, and clustered
time series will plot above the dashed line. An equal number of cases in each time interval causes m1 to be smaller than its expectation, and uniform time series plot below the
dashed line.

Session log
After ClusterSeer performs an Ederer-Myers-Mantel analysis, it will place summary
information and results into the session log. ClusterSeer reports the file used, the total
number of time series, the number of cells per series, and the number of cases in a time
series.
Ederer-Myers-Mantel results

• m1, the test statistic: the maximum number of cases observed in any of a sequence of
time intervals

• E(m1), the expected value of m1 for the Exact, Table, and Simulated values
• Var(m1), the variance of m1 for the Exact, Table, and Simulated values
• P-values for each region in the time series. Exact if available, simulated if not
• The interpolated values of E(m1) and Var(m1) (identified with an asterisk)
• The number of Monte Carlo simulations
• A list of series ClusterSeer was unable to analyze
Chi-squared statistic results
True Values

• The value of the Chi-squared statistic of the True values (if you selected Calculate
True values in the Provide data to run the Ederer-Myers-Mantel
test dialog)

• The P-value for the Chi-squared statistic of the True values
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Table Values

• The value of the Chi-squared statistic of the Table values
• The P-value for the Chi-squared statistic of the Table values
Simulated Values

• The value of the Chi-squared statistic of the simulated values
• The P-value for the Chi-squared statistic of the simulated values
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CHAPTER 21

Empty Cells Method

The Empty cells method (Grimson 1993) can detect temporal clustering in
single and several time series with group-level data. The empty cells test statistic, E, is a count of the number of time periods with no cases. This statistic
can detect temporal clustering where one or more time periods have several
cases while other time periods have none. When cases cluster the test statistic
will be large.
Use this method to detect clusters of rare events, when some of the time
periods can be reasonably expected to have zero cases.
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Empty Cells Method: Statistic
Ho

Cases occur randomly through time.

Ha

Cases cluster in one or more time periods.

Grimson (1993) gives equations for the expectation and variance under this null hypothesis as:

t–1
E ( E ) = t  ----------
t

N

E ( ( E ) 2 ) = ( t )2 t

–N

(t – 2)

N

Var ( E ) = E ( E ) ( 1 – E ( E ) ) + E ( ( E ) 2 )
Where:

•
•
•
•

N: Number of cases in a time series
t: Number of time cells
E: Test statistic, number of empty cells.
The notation (a)k indicates a falling factorial such that (a)k=a(a-1)...(a-k+1).

Significance
Under this null hypothesis we wish to determine the probability, P, of obtaining a number of empty cells greater than or equal to E. The significance of E is evaluated using the
exact P-value:

P ( E ≥ E∗ ) = ( – 1 )

E∗

t–1

∑

k ≥ E∗
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k – 1   t   t – k N
k
---------( –1 ) 
 E∗ – 1  k  t 

Empty Cells Method: Statistic

 a indicates a binomial coefficient. We want to test for clusters, and
 b
P ( E ≥ E∗ ) is evaluated as a one-tailed test.

The notation

When several time series are tested simultaneously P-values are combined using the Bonferroni approach. When at least 20% of the areas have an expected number of empty
cells of 5 or more the results can be combined as a continuity-corrected Chi-squared statistic with one degree of freedom.

2

t
 t


Ei –
E ( E i ) – 0.5




i
=
1
i
–
1
2
x = ----------------------------------------------------------------------

∑

∑

t

∑ Var( Ei )

i=1

Here the i subscript indicates a statistic for the ith time series, the summations are over
the cells/time periods within each series, E is the sum of the number of empty cells, and
E(E) and Var(E) are the mean and variance of E under the assumption of a random allocation of disease cases among the cells.
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Empty Cells Method: How to
Choose Empty Cells method from the Analysis menu. (Temporal|Single or
Several time series submenus).
In a series of dialogs, ClusterSeer will prompt you to submit the file to analyze. If you
submitted a suitable dataset in the previous analysis, you will jump directly to the
Choose settings step listed below.

Submit data file
1.

ClusterSeer will prompt you to submit the data file (text file or DBF).
DBFs must have a column of labels. If you submit a text file without a label column,
ClusterSeer will use the row number as the label, which assumes that the sequence of
case counts in the file increases with the row number.
The text or DBF file should contain group-level data with the following columns in
the following order:

For single time series:
Time Sequence Label

Case Count

(required for DBF files only)

For several time series:

2.

Region Label

Case Count

Case Count

Case Count

(required for
DBF files only)

Time 1

Time 2

Time 3

...

If your data file includes labels, choose Selected data file contains label. If
your data have no labels, select Use study row # as label.

Choose settings
3.

In the Provide data dialog, you may use the Select File button to change your
file choices.

4.

Enter the number of time series in your dataset. For a single time series, enter 1. For
several time series, enter the total number of locations where you collected data for
consecutive intervals of equal length.
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Run the analysis
5.

After you hit OK, ClusterSeer will establish nearest neighbor relationships. If you hit
Stop at this point, the procedure will cancel.

6.

Then, ClusterSeer will run the Monte Carlo simulation. You may stop the simulations
at any time using the Stop button on the progress bar. The stop button will halt the
simulations and the results will be displayed for the number of Monte Carlo runs
completed by the time you pressed the button.
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Empty Cells Method: Results
Plot
Choose Plot from the View menu to view the plot. ClusterSeer plots the observed statistic (E) on its expectation (E(E)) for single and several time series. The time series is
the single red point on the graph. The blue line is the identity function (observed =
expectation) describing where observations would be plotted under the null hypothesis.
Significant clustering will cause E to be larger than its expectation, and observations will
plot above the blue line.

Session log
After ClusterSeer performs an Empty Cells analysis, it will place summary information
and results into the session log.
ClusterSeer also provides a table of the test statistic, the count of empty cells E, and a list
of time series ClusterSeer was unable to analyze.
Significance Values

•
•
•
•

The expectation of the number of empty cells E(E)
The variance of the number of empty cells Var(E)
The upper-tail P-value to assess the significance of the observed value of E
Overall Bonferroni P-value or Chi-squared statistic with a P-value (for multiple time
series only)

When several time series are tested simultaneously P-values are combined using the Bonferroni approach. When at least 20% of the areas have an expected number of empty
cells of 5 or more, the results can be combined as a continuity-corrected Chi-squared statistic with one degree of freedom.
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CHAPTER 22

Getis-Ord Local G

The local G statistics are used to test for spatial clustering in group-level data
(Getis and Ord 1992; Ord and Getis 1995). These statistics make it possible
to assess the spatial association of a variable within a particular distance of
each observation. Local G statistics may detect local clusters that exist despite
negative tests for global spatial autocorrelation.

Examples
Jeffery et al. (2002) used the Local G statistic to examine the spatial pattern
of mosquito vectors of the Ross Rover virus and the Barmah Forest virus on
Russell Island, Queensland, Australia. They found significant clustering on
the southern end of Russell Island. Ratcliffe and McCullagh (2001) located
hotspots in crime in Nottinghamshire using the Local G statistic. They then
compared statistical clusters with the perceived high crime areas. Ceccato and
Persson (2002) used the Local G to study spatial clustering of employment in
Sweden. They found clusters of employment in areas with private businesses,
and clusters of low employment in areas where the government is the main
employer.
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Getis-Ord Local G Method: Statistic
Ho

There is no clustering of high or low values within the specified
distance of location i, and the test statistic is close to zero.

Ha

There is clustering of high or low values within the specified
distance of point i. A significant positive value implies a
clustering of high values, and a significant negative value
indicates a clustering of low values.

The statistic measures the degree of association that results from the concentration of
weighted points or region centroids and all other weighted points within distance d from
the point of study (Getis and Ord 1992).
The basic statistic is defined as:

∑ wij ( d )xj
j

G i ( d ) = ---------------------------xj

∑
j

In this equation, the xj are the weighted values of the points in the study area. wij is a
binary, symmetric weights matrix with ones for all points j within distance d of point i
and zeros otherwise.
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There are two variants of the local G statistic. The Gi statistic excludes the value at i from
the summation and is used for spread or diffusion studies, while the Gi* includes the
value at i in the summation and is most often used for studies of clustering.

Significance
In (Ord and Getis 1995) the authors reformulated the statistic so that the results are
given in standard normal variants. The statistic is normally distributed, and can be used
for normal as well as skewed frequency distributions of the underlying variable. However, when the number of neighbors is small the statistic is less reliable.
The significance of each local G value may also be evaluated using a Monte Carlo randomization procedure.
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Getis-Ord Local G Method: How to
Choose Getis-Ord Local G method from the Analysis menu. (Spatial| Local
submenus).
In a series of dialogs, ClusterSeer will prompt you to submit the file to analyze. If you
submitted a suitable dataset in the previous analysis, you will jump directly to the
Choose settings step listed below.

Submit data file
1.

ClusterSeer will prompt you to submit the data file (text, DBF, or point shapefile).
If you submit a text file with a header, a shapefile, or DBF, ClusterSeer will prompt
you to identify which columns in your file contain the required data. In this case, the
columns can be in any order.
If it is a text file without a header, it should contain individual-level data with the following columns in the following order.
centroid label

centroid x-coordinate (not for shapefile)

centroid y-coordinate (not for shapefile)

disease frequency

2.

You will need to specify the coordinate system of the data. If the data are in geographic coordinates, you will also need to choose a distance measurement.

3.

If your data file includes labels, choose Selected data file contains label. If
your data have no labels, select Use study row # as label.

Choose settings
4.

In the Provide data dialog, you may use the Select File button to change your
file choices.

5.

Select the distance of study. When a new dataset is selected, the initial distance shown
in the dialog is the largest nearest neighbor distance in the study area. This ensures
that each point will have at least one neighbor in the analysis. Any distance may be
chosen; however, the selected distance should be based on a hypothesis about the
nature of the clustering or diffusion forces underlying the data.

6.

Select either a Gi or Gi* test.

7.

Choose the number of Monte Carlo runs, the number of simulations used to determine statistical significance of the test statistic. The default value is 999.
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8.

Enter the significance level you wish to use for the test. The significance level is the
alpha level, the cutoff for statistical significance. The default value is 0.05.

Run the analysis
9.

After you hit OK, ClusterSeer will establish nearest neighbor relationships. If you hit
Stop at this point, the procedure will cancel.

10.

Then, ClusterSeer will run the Monte Carlo simulation. You may stop the simulations
at any time using the Stop button on the progress bar. The stop button will halt the
simulations and the results will be displayed for the number of Monte Carlo runs
completed by the time you pressed the button.
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Getis-Ord Local G Method: Results
Distribution
You can view a histogram that shows the reference distribution from the Monte Carlo
simulations. ClusterSeer has a Monte Carlo distribution for each region in your dataset.
Choose MC Distribution from the View menu. Next, ClusterSeer will prompt you to
choose a region from the list of regions in your dataset.
The distribution of test statistics from the simulations will appear as gray bars, and the
observed test statistic will be drawn as a slim black line.

Map
Choose Map from the View menu to view the map. The map has three layers: clusters
of high values, region centroids (observations), and a map showing the selected distance
for all points
If you query a region centroid, you will be able to view its label, x, and y coordinates, disease frequency, local test statistic, normal P-value, and Monte Carlo P-value at the point.

Layer
clusters of high values
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If you query a cluster layer, you can view
the center area label, center x, y coordinates, local test statistic, normal P-value,
Monte Carlo P-value, and the local disease
frequency.

Getis-Ord Local G Method: Results

Layer
region centroid

When you query the region centroid, you
can view its label, x, and y coordinates, disease frequency, local test statistic, normal
P-value, and Monte Carlo P-value at the
point.

distance layer

The same attributes as the cluster layer can
also be found for each point by querying a
circle in the selected distance layer.

Session log
After ClusterSeer performs a Getis-Ord analysis, it will place summary information and
results into the session log.
Summary Information and Parameters:
Where applicable, ClusterSeer reports conversion information from geographic to planar
coordinate systems. It also reports the total number of regions and the average disease
frequency.
Local Gi or Gi* Test Summary information:

•
•
•
•
•
•
•
•
•

File name
Coordinate system conversion information
Total number of regions
Specified alpha level
Number of Monte Carlo simulations
Distance of analysis
Locations with significant clustering and the corresponding test statistic
P-value
Monte Carlo P-value
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CHAPTER 23

Grimson’s Method

Grimson's method (Grimson 1989, Grimson and Rose 1991) is a versatile
test used to detect space, time or space-time clustering in time series and/or
point data. It can be used with individual-level or group-level data. Grimson’s
method is sensitive to a high number of adjacent high risk events. The data
may consist of items labeled cases for individual point data, high risk areas
for group-level data, or high-risk time periods (e.g. when an exposure or diagnosis occurred) for time series data.

ClusterSeer User Guide 2

225

Grimson’s Method

Grimson's Method: Statistic
Ho

The objects have been labeled at random, there is no clustering.

Ha

High risk items tend to be adjacent, there is clustering.

Test Statistic
The test statistic, A, is the count of the number of pairs of labeled objects that are adjacent to one another in a time series or in space, or both. The objects can be locations of
cases and controls, high risk areas or time periods. Objects may border each other in
space (sharing a common boundary), or time (adjacent in a time series). The expected
value of A when there is no clustering of events is:

yn ( n – 1 )
E ( A ) = ----------------------2(x – 1)
Here x is the total number of items (both labeled and not labeled), n is the number of
labeled items, and y is the average number of borders per item (neighbors in time and/or
space). When high-risk items cluster there will be an excess of adjacencies and the test
statistic will be large.
The variance of A is:
2 ( y – 1 ) + ( n – 2 ) ( xy – 4y + 2 ) ( n – 2 ) ( n – 3 )
Var ( A ) = E ( A )  1 + ------------------------------------------- + ------------------------------------------------------------------ – E ( A ) ) +

x–2
2(x – 2)(x – 3)
( n )4
( n )3
Var ( y )  ------------------- – ------------------- 
 ( x – 1 )2 ( x – 1 )3 

The variance of A has two components, the regularity component (RC) and the variability component (VC). RC is the first part of the expression (RC = E(A)[....]) and VC is the
second part (VC = Var(y)....).

Significance
ClusterSeer evaluates the significance of A using the Poisson or the normal distribution.
The first assumes A is sampled from a Poisson distribution with a mean given by E(A).
The second assumes the z-score is sampled from a normal distribution with mean of 0
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and variance 1.0. Both approaches yield a one-tailed test describing the probability, under
the null hypothesis, of obtaining a test statistic as large or larger than the one already
observed.

Which distribution is right for my data?
Whether to use the Poisson or the normal approach depends on the proportion of the
variance, Var(A), contributed by the variability component, VC. This is `VC / Var(A)'.
Grimson (1991) offers the following guidance:

• Use the Poisson approach when VC / Var(A) is small
• Use the normal approach when VC / Var(A) is large.
Our rule of thumb is to use the Poisson approach when VC / Var(A)< 0.20, otherwise
use the normal approach. The mean and variance of the Poisson distribution are equal,
thus E(A) and Var(A) should be approximately equal in order to use the Poisson
approach.
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Grimson's Method: How to
Choose Grimson’s method from the Analysis menu. As it is a flexible test, it can
be found under a series of submenus: (Spatial|Global) or (Temporal|Single or
Several) or (Spatio-temporal).
In a series of dialogs, ClusterSeer will prompt you to submit the file to analyze. If you
submitted a suitable dataset in the previous analysis, you will jump directly to the
Choose settings step listed below.
ClusterSeer can either test parameters you enter in the dialog or it can calculate the necessary parameters from data files you submit. To use the files, you will need to submit
two files: a data file (a text file), and a file of contiguities or adjacencies (text or gal file).
See pp. 42-44 of the first ClusterSeer user guide for information on text and contiguity
file guidelines.

Enter parameters directly
You can calculate the parameters needed to run Grimson’s method outside of ClusterSeer and then enter them into the dialog box that appears. Because of the complexity of
the variance calculation, submitting the files to allow ClusterSeer to calculate the parameters from a file may be the easier approach.
Then, enter the following parameters directly into the dialog:

•
•
•
•
•

Total number of objects
Number of labeled objects
Average number of borders
Variance of the number of borders
Number of adjacent labeled pairs

OR

Enter your parameters automatically using file
information
1.

Use the Select file button to choose your files.

Grimson: Disease data file
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2.

For Grimson's method, you can submit two files for ClusterSeer to calculate the
parameters used in Grimson's method. You will need to submit a disease data file and
a contiguity file. For the disease file, ClusterSeer is flexible. It can accept two types of
disease data: risk labels and case counts.

Risk label
3.

For the risk label files, you will submit a text file that holds two columns of data: the
label (for the location or time period) and the risk label (0 for low risk, 1 for high
risk).

Case count
4.

ClusterSeer will calculate the risk labels for analysis from case count data. Use the dialog to define what you consider a high risk case count. You can set it to any cell with
a case count equal to (=), not equal to (not =), less than (<), greater than (>), less
than or equal to (<=), or greater than or equal to (>=) a specified value. Objects are
labelled high risk if they have a case count of 2.
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Grimson’s Method: Results
Plot
To view the plot, choose Plot from the View menu.
The plot shows the significance of A against the value of A. The Poisson significance is
shown by the red points. The blue points are significance under the normal approach.
The vertical green line is the observed number of adjacent high-risk quarters. The intersection between the Poisson and normal curves and the vertical line are the P-values
under the Poisson and normal assumptions. The P-values are different for the Poisson
and normal distributions. See “Which distribution is right for my data?” on page 227.

Session log
Once ClusterSeer has performed a Grimson's analysis, it writes information on the analysis and results into the session log.
Data and analysis input

•
•
•
•
•
•

Data sets used
Number of objects
Number of labelled cells
Average number of borders per cell
Sample variance for number of borders
The test statistic A, the number of adjacent labelled cells.

Results
ClusterSeer will then report the results of the analysis. These include the variance components RC and VC calculated from the data, the expected value of A (EA), its variance,
and the z-score.
ClusterSeer reports two upper-tail P-values, one obtained from the normal approach and
the other from the Poisson approach. Use the Poisson approach when VC/Var(A) is
small, and the normal approach when VC/Var(A) is large (Grimson 1991). One rule of
thumb is to use the Poisson approach when VC/Var(A)<0.20; otherwise, use the normal approach. See “Which distribution is right for my data?” on page 227.
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CHAPTER 24

Jacquez’s k- NN

Jacquez's k-Nearest Neighbor test is a test for space-time interaction for individual-level data. The test statistic, Jk, is the count of the number of case pairs
that are nearest neighbors in both space and time. When space-time interaction exists Jk will be large, since nearest neighbors in space will also tend to
be nearest neighbors in time.

Examples
Norstrom et al. (2000) used the k-NN method to evaluate outbreaks of acute
respiratory diseases in Norwegian cattle herds. They found significant spacetime clustering of cases, providing evidence of a single infection source for
the outbreak. Van Buuren et al. (1998) found no significant space-time clustering of multiple sclerosis cases in The Netherlands using the k-NN
method.
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Jacquez's k-NN Method: Statistic
Ho
Ha

Whether cases are nearest neighbors in space is independent of
whether they are nearest neighbors in time.
Nearest neighbors in space tend to be nearest neighbors in time.

Test statistic
The test statistic, Jk, is the count of the number of case pairs that are k nearest neighbors
in both space and time. When space-time interaction exists Jk will be large, since nearest
neighbors in space will also tend to be nearest neighbors in time.

N

Jk =

N

∑ ∑ sijk tijk
i = 1i = 1

Where:

• k is the number of nearest neighbors to consider in the analysis (if k=1, consider the
first nearest neighbor; if k=2 consider the first and second nearest neighbors).

• sijk is the spatial nearest neighbor (NN) measure, sijk =1 if case j is a k-NN of case i in
space, and 0 otherwise.

• tijk is the time NN measure, tijk =1 if case j is a k-NN of case i in time, and 0 otherwise.
The Jk are not independent because case pairs counted as nearest neighbors when k is
small are included when higher numbers of neighbors are considered. For example, J2 is
the count of the number of pairs that are first and second nearest neighbors in both
space and time. DJk is the number of space-time nearest neighbors added by increasing k
by 1. DJk measures space-time interaction above and beyond that observed for the k-1
nearest neighbors. Jk, on the other hand, is a cumulative measure of space-time interaction where all nearest neighbor relationships from 1 up to k are included.
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DJ k = J k – J k – 1
Significance
ClusterSeer evaluates the significance of Jk using an approximate randomization of the
Mantel product. Let Sk denote the matrix of spatial nearest neighbor measures (the sijk),
and let Tk denote the matrix of time nearest neighbor measures. P-values are calculated
by comparing the observed Jk to the distribution of Jk obtained under Monte Carlo randomization. The elements of Tk are shuffled by permuting its rows and columns and Jk
is then calculated. This procedure is repeated a fixed number of times, resulting in a distribution of Jk under the null hypothesis of no association between the space and time
nearest neighbor relationships.
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Jacquez's k-NN Method: How to
Choose Jacquez's k-Nearest Neighbor Method from the Analysis menu
(Spatio-temporal submenu).
In a series of dialogs, ClusterSeer will prompt you to submit the file to analyze. If you
submitted a suitable dataset in the previous analysis, you will jump directly to the
Choose settings step listed below.

Submit data file
1.

ClusterSeer will prompt you to submit the data file (text file, DBF, or point shapefile).
ClusterSeer expects case event timepoints as user-defined integers. See “Temporal
data formats” on page 174.
If you submit a text file with a header, a shapefile, or DBF, ClusterSeer will prompt
you to identify which columns in your file contain the required data. In this case, the
columns can be in any order.
If you wish to submit a text file without a header, it should contain individual-level
data with the following columns in the following order

Space-Time Case File:
case level

case event

case event

(optional unless
you are submitting a DBF)

x-coordinate
(not for shapefile)

y-coordinate
(not for shapefile)

case event timepoint (userdefined integer)

2.

You will need to specify the coordinate system of the data. If the data are in geographic coordinates, you will also need to choose a distance measurement.

3.

If your data file includes labels, choose Selected data file contains label. If
your data have no labels, select Use study row # as label.

Choose settings
4.

In the Provide data dialog, you may use the Select File button to change your
file choices.

5.

Enter the number of case pairs that are k-Nearest Neighbors in both space and time.

6.

Enter the number of Monte Carlo Randomization runs.
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Run the analysis
7.

After you hit OK, ClusterSeer will establish nearest neighbor relationships. Then,
ClusterSeer will run the Monte Carlo simulation. You may stop the simulations at any
time using the Stop button on the progress bar. The stop button will halt the simulations and the results will be displayed for the number of Monte Carlo runs completed by the time you pressed the button.
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Jacquez’s k-NN Method: Results
Monte Carlo distribution
You can view the Monte Carlo distribution by choosing MC Distribution from the
View menu.
This histogram shows the reference distribution generated by randomizing the dataset
and recalculating the observed value. The relative position of the observed value of Jk is
illustrated by a slim, vertical black line.

Map
Choose Map from the View menu. ClusterSeer will display a map of the cases’ spatial
distribution.
If you query one of these points, you will be able to view its label, spatial coordinates, and its time of occurrence.

Session log
After ClusterSeer performs a Jacquez’s k-Nearest Neighbor analysis, it will place summary information and results into the session log.

• The file used
• The number of cases analyzed
Jacquez’s k-NN results
ClusterSeer will provide a table of results, including the test statistics Jk and DJk at each k
and P-values for each test statistic obtained by Monte Carlo randomizations.
ClusterSeer also provides the Statistical Distance Test Statistic for the combined Monte
Carlo simulation runs at each k, its P-value, and Bonferroni and Simes combined P-values for J and DJ over all k analyzed.
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CHAPTER 25

Knox’s Method

Knox's method (Knox 1963, 1964) quantifies space-time interaction for individual-level data. The test statistic, X, is a count of those pairs of cases that
are separated by less than the critical space and time distances. Pairs of cases
will be near to one another when interaction is present, and the test statistic
will be large.

Example
Gilman et al. (1999) assessed patterns in acute lymphoblastic leukemia in the
UK using the Knox method. They found space time clustering only in children 0-14 years, particularly those diagnosed in 1984-88. This pattern could
be explained by an infectious etiology or due to exposures to an environmental hazard. Machado-Coelho et al. (1999) used the Knox test to study American cutaneous leishmaniasis (ACL) in Brazil. They found significant spacetime pattern in ACL cases.
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Knox’s Method: Statistic
Ho

Ha

The times of occurrence of the health events are distributed
randomly across the case locations. This is another way of saying
the time distances between pairs of cases are independent of the
spatial distances between pairs of cases.
Pairs of cases near in space tend to be near in time.

Test statistic
The test statistic, X, is the number of pairs of cases that are near to one another in both
space and time. Pairs of cases will be near to one another when interaction is present,
and the test statistic will be large.

N i–1

x =

∑ ∑ sij tij
i = 1j = 1

Where:

• N is the number of cases
• sij is the space adjacency value, 1 if the distance between cases i and j is less than the
critical space distance and 0 otherwise

• tij is the time adjacency value, 1 if the waiting time between cases i and j is less than
the critical time distance and 0 otherwise.
To run Knox's method, you need to specify the critical space and time distances (Dcrit
and Tcrit respectively), so that sij and tij can be calculated. Pairs of cases separated by less
than the critical space distance are considered to be near in space. Pairs of cases separated by less than the critical time distance are said to be near in time. If you do not know
what critical distances to use, ClusterSeer will use the mean calculated from the dataset.
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Significance
ClusterSeer calculates the null distribution of X in two ways: using a Chi-squared test and
using Monte Carlo simulations. The Chi-squared test calculates the probability of the
classification of events into near in space and near in time; near in space, far in time; far
in space, near in time; and far in space and time under the null hypothesis of no clustering. This provides a significance based on a comparison of the observed and expected
values of X.

Critical values
Knox's method detects clustering using threshold values, critical time and space distances. Pairs of cases separated by less than the critical space distance are considered to
be near in space. Pairs of cases separated by less than the critical time distance are said to
be near in time. To run Knox's method, you need to supply these critical values.

The plot above (not from ClusterSeer) shows the time critical value as a horizontal line,
the spatial distance critical value as a vertical line. Pairs of events are categorized as near
or far in space and time. There are 4 categories or classifications, as shown on the plot.
How do you determine when cases of a disease are "close enough" in time or space?
Knox designed this method to account for latency periods. A latency period is the time
between exposure and the manifestation of symptoms. If you suspect a disease with a
latency period of 3 days set the time critical distance long enough to allow symptoms to
appear, say 4 or 5 days. For infectious diseases, the geographic critical distance reflects
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the average distance between 2 individuals, one of whom infected the other. In general,
one selects critical distances consistent with the disease hypothesis under investigation.
This hypothesis based approach avoids problems of subjectivity which arise when critical
values are determined from the data.
However, when knowledge of the underlying disease process is absent, critical values can
be quantified based on the distributions of space and time distances. This approach is
crude and should only be used when an epidemiologic hypothesis is lacking. In these
instances use the mean geographic distance for Dcrit and the mean time distance for
Tcrit. You can systematically vary the critical distances to identify those values that maximize Knox's X. This can provide insight into the spatial and temporal scale of the disease process, but precludes any formal evaluation of statistical significance because of
multiple tests. Do not choose critical distances larger than the maximum distance in the
data, since the number of cases near in both space and time will always be zero.
Mantel's method is another space-time test which does not require selecting critical distances.
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Knox’s Method: How to
Choose Knox’s Method from the Analysis menu (Spatio-temporal submenu).
In a series of dialogs, ClusterSeer will prompt you to submit the file to analyze. If you
submitted a suitable dataset in the previous analysis, you will jump directly to the
Choose settings step listed below.
This analysis requires a single file of case event data. Files should follow ClusterSeer general data requirements. ClusterSeer expects case event timepoints as user-defined integers. See “Temporal data formats” on page 174.
1.

ClusterSeer will prompt you to submit the data file (text file, DBF, or point shapefile).
If you submit a text file with a header, a shapefile, or DBF, ClusterSeer will prompt
you to identify which columns in your file contain the required data. In this case, the
columns can be in any order.
If you wish to submit a text file without a header, it should contain individual-level
data with the following columns in the following order

Space-Time Case File:
case level

case event

case event

(optional unless
you are submitting a DBF)

x-coordinate
(not for shapefile)

y-coordinate
(not for shapefile)

case event timepoint (userdefined integer)

2.

You will need to specify the coordinate system of the data. If the data are in geographic coordinates, you will also need to choose a distance measurement.

3.

If your data file includes labels, choose Selected data file contains label. If
your data have no labels, select Use study row # as label.

Choose settings
4.

In the Provide data dialog, you may use the Select File button to change your
file choices.

5.

Specify the distance and temporal cutoffs. Select whether or not you want to use
means as cutoffs. See “Critical values” on page 239.

6.

Enter the number of Monte Carlo Randomization runs.
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Run the analysis
7.

After you hit OK, ClusterSeer will establish nearest neighbor relationships. Then,
ClusterSeer will run the Monte Carlo simulation. You may stop the simulations at any
time using the Stop button on the progress bar. The stop button will halt the simulations and the results will be displayed for the number of Monte Carlo runs completed by the time you pressed the button.
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Knox’s Method: Results
Monte Carlo distribution
You can view the Monte Carlo distribution by choosing MC Distribution from the
View menu.
This histogram shows the reference distribution generated by randomizing the dataset
and recalculating the observed value. The relative position of the observed value of X is
illustrated with a slim, vertical black line.

Map
You can view the map by choosing Map from the View menu.
The map of Knox results has seven layers, one layer showing the original data (cases) and
six showing the analysis results. When the map is first displayed, not all of the layers are
active (checked in red on the left layers pane and shown in the middle pane of the map).
You can toggle map layers on and off by checking or clearing the red check using the
mouse pointer.

Layer
type

Layer

Contents

Point Layer

Close in Space and

Those points that are close in space and time to at
least one other point

Time

Link Layers

Close in Time

Those points that are close in time to at least one
other point

Close in Space

Those points that are close in space to at least one
other point

Cases

The point locations of all cases in the dataset

Space-Time Links

The links between pairs of points that are near in
space and time

Time Links

The links between pairs of points that are near in
time

Space Links

The links between pairs of points that are near in
space
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To query a particular layer, make sure it is highlighted on the layers list (left map
panel).

• If you query a point layer (cases, close in space, close in time, or close in space and
time), you will see information on the point nearest the query location. The label, xcoordinate, y-coordinate, and the time of its occurrence.

• If you query a links layer (space links, time links, or space-time links), you will see the
layer name and the coordinates of the location queried.

Session log
After ClusterSeer performs a Knox analysis, it will place summary information and
results into the session log:

•
•
•
•

The file used,
The number of cases analyzed,
The critical values, Dcrit and Tcrit,
A 2x2 matrix categorizing pairs of cases in the dataset as close or far in space and
time.

Chi-square results
ClusterSeer reports the expected test statistic and the Chi-squared P-value.
The Chi-squared test calculates the probability of the classification of events into near in
space and near in time; near in space, far in time; far in space, near in time; and far in
space and time under the null hypothesis of no clustering. This provides a significance
based on a comparison of the observed and expected values of X.
Monte Carlo results

• The test statistic X
• The number of Monte Carlo simulations
• The P-value for the test statistic through comparison with the Monte Carlo distribution.
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Kulldorff’s Spatial Scan

Kulldorff's Spatial Scan method (Kulldorff and Nagarwalla 1995, Kulldorff
1997) can detect local space clusters in group-level data. The first ClusterSeer
manual page 75 describes Kulldorff ’s Spatio-Temporal scan. ClusterSeer 2
now offers the space-only version. The scan statistic uses a circular window
to identify excesses of cases in space. At each spatial location, a circular window increases in size until it reaches an upper size limit.
The scan statistic provides a measure of whether the observed number of
cases is unlikely for a window of that size, using reference values from the
entire study area. By searching for clusters without specifying their size or
location, the method avoids pre-selection bias.
Kulldorff (1997) developed two models, a Poisson model and a Bernoulli
model. For a small number of cases, the two models are similar. The Bernoulli model is best for questions about case and control samples, while the
Poisson model better answers questions with case and population-at-risk
counts. At this point, ClusterSeer implements the Poisson method.
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Examples
Doherr et al. (2002) used the spatial scan statistic to analyze spatial clustering in cases of
bovine spongiform encephalopathy (BSE) in Switzerland. They found significant spatial
clustering in BSE cases, and they excluded differential reporting as a possible cause of
the observed clustering. Ward and Carpenter (2000) used the spatial scan statistic to
identify patterns in blowfly strike infestation in commercial sheep flocks in Australia.
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Kulldorff's Spatial Scan Method: Statistic
(Poisson)
Ho

The null spatial model is an inhomogeneous Poisson point process
with an intensity, µ , proportional to the population-at-risk.

Ha

In some locations in the space, the number of cases exceeds that
predicted under the null model.

Test statistic
For the spatial scan, a circular window is moved systematically through the study area.
The scan window starts at each location in the dataset. ClusterSeer’s implementation of
the spatial scan calculates the locations to include in the window using the centroids of a
submitted polygon file. The window expands to include the nearest region centroids.
The maximum size of each window will not exceed 50% of the total population-at-risk
size for the study period.
The hypotheses are evaluated with a maximum likelihood ratio test that examines
whether the null or alternative model better fits the data (notation follows Kulldorff
1999). The scan statistic is the maximum likelihood ratio over all possible window sizes.
Its P-value is obtained through multinomial Monte Carlo randomizations. If the null
hypothesis is rejected, ClusterSeer reports the spatial or spatio-temporal location and the
extent of the cluster that caused the rejection.

Likelihood ratio
The likelihood ratio is

nz nz N – nz N – nz
 -----------   ---------------------- 
 µ( Z )  N – µ( Z )
L
(
Z
)
----------- = ---------------------------------------------------------------L0
N N
 ---------- µ ( A )
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if

nz

>

1
µ ( Z ) , -----L0

otherwise

µ ( Z ) is the expected number of cases
in cylinder Z. The observed (N) and expected µ ( A ) number of cases are calculated

Where nz is the observed number of cases and

over the entire study area, across all time periods.
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Kulldorff's Spatial Scan Method: How to
You can perform a Kulldorff's Scan in one of three ways, submitting population-at-risk
counts directly with case counts, extrapolating population-at-risk counts from census
data, or submitting a shapefile of polygons with case and population-at-risk counts.
Only the method new to ClusterSeer version 2 is described here. See the first ClusterSeer
user guide (pp. 77-80) for a description of how to submit population at risk counts or
census data.
Note: For the polygon shapefile, if there are islands or non-contiguous areas, the analysis
will not run.

Submit shapefile
Choose Kulldorff’s Scan method from the Analysis menu (Spatial|Local
submenus).
In a series of dialogs, ClusterSeer will prompt you to submit the file to analyze. If you
submitted a suitable dataset in the previous analysis, you will jump directly to the
Choose settings step listed below.
1.

ClusterSeer will prompt you to submit a point or polygon shapefile, text or DBF file.
If you submit a shapefile, DBF, or text file with a header, ClusterSeer will prompt you
to identify which columns in your file contain the required data. In this case, the columns can be in any order.
If you wish to submit a text file without a header, it should contain group-level data
with the following columns in the following order:
region label

region centroid xcoordinate (not for
shapefile)

region centroid ycoordinate (not for
shapefile)

case count

population-atrisk count

2.

You will need to specify the coordinate system of the data. If the data are in geographic coordinates, you will also need to choose a distance measurement.

3.

If your data file includes labels, choose Selected data file contains label. If
your data have no labels, select Use study row # as label.

Choose settings
4.

In the Provide data dialog, you may use the Select File button to change your
file choices.
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5.

Choose the number of Monte Carlo runs, the number of simulations used to determine statistical significance of the test statistic. The default value is 999.

Run the analysis
6.

After you hit OK, ClusterSeer will establish nearest neighbor relationships. If you hit
Stop at this point, the procedure will cancel.

Then, ClusterSeer will run the Monte Carlo simulation. You may stop the simulations at
any time using the Stop button on the progress bar. The stop button will halt the simulations and the results will be displayed for the number of Monte Carlo runs completed by
the time you pressed the button.
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Kulldorff’s Spatial Scan Method: Results
Monte Carlo distribution
This histogram shows the reference distribution generated by randomizing the dataset
and recalculating the test statistic. See p. 80 of the first ClusterSeer manual for details on
Spatial and Spatio-Temporal Kulldorff ’s Scan distributions.

Map
To see the map, choose Map from the View menu. The map will display two layers:
region centroids, shown as points, and cluster extent, shown as a circular outline for each
of the three most likely clusters. The second and third most likely clusters are chosen
using two criteria: 1) the value of the test statistic and 2) whether they overlap higherranking clusters (the second will not overlap the first, the third will not overlap the second or the first).

To query a particular layer, make sure it is highlighted on the layers list (left
map panel).

For the Spatial

Scan

For the Space-Time

Layer

Scan

region
centroids

You can view the region label,
case count, and population at
risk count.

You can view the region label, xand y- coordinates, case count, and
population at risk count.

cluster
extent

You can find its centering
region label, x- and y- coordinates, case count and population count.

You can find its centering region
label, x- and y- coordinates, start
and end periods for the cluster,
local test statistic, disease frequency,
P-value, and a list of other regions
included in the cluster.
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Plot
The spatial scan has no plot option. See page 81 of the first ClusterSeer manual for information about the spatio-temporal scan’s plot.

Session log
Once ClusterSeer has performed a Kulldorff's Scan analysis, it writes information on the
procedure and results into the session log.

252

Kulldorff’s Spatial Scan Method: Results

Session Log
Topics

For the Spatial Scan

For the SpatioTemporal Scan

Summary Information & Parameters

• Number of regions,

• Number of regions, study

number of cases, population-at-risk size, average disease frequency

• Variable analyzed (case
count, population
count), maximum spatial population radius
analyzed, number of
Monte Carlo simulations performed
Information on
each of the three
most likely clusters:

The second and
third most likely
clusters are chosen using two criteria: 1) the value
of the test statistic
and 2) whether
they overlap
higher-ranking
clusters (the second will not overlap the first, the
third will not overlap the second or
the first).

period span, number of
cases, population-at-risk
size, average disease frequency

• Maximum population
radius, maximum temporal span, number of Monte
Carlo simulations

• Regions included (start- • Regions included (starting
ing with the centering
region, with remaining
regions ordered from
nearest to farthest)

• Disease frequently
(averaged over the spatial span)

• Log likelihood ration
• Upper tail Monte Carlo
P-value

with the centering region,
with remaining regions
ordered from nearest to
farthest)

• Cluster temporal span
• Disease frequency (averaged over the cluster temporal span)

• Log likelihood ratio
• Upper tail Monte Carlo Pvalue
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CHAPTER 27

Larsen’s Method

Larsen's method can detect temporal clustering in single and several time
series with group-level data. Larsen's test statistic K is sensitive to a unimodal
clustering of occupied cells.
The normality assumption used to evaluate significance does not hold when
the time series is shorter than 10 intervals. When you use Larsen's method to
analyze time series with fewer than 10 intervals, the method will not be very
powerful. For short time series consider using smaller time intervals or perhaps collecting data from additional time periods. As alternatives consider
the Empty Cells method, or Dat's 0-1 matrix method when cases are numerous.
Larsen's method also requires two or more of the time intervals to have
cases. Time series with fewer than 2 occupied intervals are excluded from an
analysis. Each time series must have at least 1 unoccupied cell.
You cannot use Larsen's method with rates. Counts are required and the
method is biased by changes in population size through time.

Example
Larsen et al. (1973) used the method for simultaneous clustering in several
time series to screen for clusters of cases of children with acute leukemia in
18 census tracts in Atlanta, Georgia. Attention was brought to these data
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because the leukemia within census tracts appeared to cluster. Upon further scrutiny, single leukemia clusters were identified in 10 of the tracts. The data showed significant unimodal clustering when all of the census tracts were considered simultaneously.
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Larsen's Method: Statistic
Ho

Cases occur randomly through time. t is the total number of time
periods.

Ha

Cases cluster about a single point in time.

Test statistic
The test statistic K, measures the tendency of time periods with at least one case to form
a single cluster in time. It is

m

K =

∑

yi – yr + 1

i=1
Where:

• m is the number of time periods with at least one case.
• yi is the time assigned to the ith cell in which a case occurred.
• (r+1) is the index of the ‘central most’ time cell that contained a case, r = m ⁄ 2 .
• The floor function of x is the largest integer that is less than or equal to x.
• This method measures dispersion of cases about a central time period. K will be small
when cases form a single time cluster.

Significance
ClusterSeer calculates the expected test statistic (E(K)), the variance (Var(K)), z-scores,
grand z-scores, lower-tail P-values and overall P-values to help you evaluate the significance of the test statistic.
The expectation and variance of K under the null hypothesis are:
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m+1
(t + 1) m
---- ------------2
2
E ( K ) = -----------------------------------------------m+1
2

2

r ( t + 1 ) ( t – m ) ( ( m + 1 ) – 2r – δ ( m ) )
Var ( K ) = -----------------------------------------------------------------------------------------------+ 1 + 1 2
12  2 m
-----------

2
Where (m) = r - 2 when m is odd, and (m) = 2r - 1 when m is even.
Larsen's method uses the z-score to determine whether occupied time cells within an
area tend to occur in a sequence. This method uses an overall z-score to identify unusual
pattern over time which may not necessarily be the same over the individual areas.

K – E( K)
z = ----------------------- , as distributed as N (0,1)
Var ( K )
• A z-score of 0 is consistent with a random allocation of occupied cells across the
time series.

• K will be smaller than E(K) when occupied time intervals form a unimodal cluster,
and the z-score will be less than 0.

• K will be large when occupied time intervals form several clusters. Thus, Larsen’s
method cannot distinguish a uniform distribution from multiple clusters.

• A uniform distribution of occupied time intervals through time, such as '01010101'
will cause K to be larger than E(K), and the z-score will be greater than 0.
Significance is therefore evaluated as a one-tailed test describing the probability, under
the null hypothesis, of obtaining a K as small or smaller than the observed.
The lower-tail P-value for K is obtained by comparing the z-score to the percentiles of
the normal distribution.
When the data consist of several time series, the K statistics from each time series can be
combined into a grand z-score as:
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S

S

i=1

i=1

∑ Ki – ∑ E ( Ki )

Z G = -----------------------------------------------S

∑ Var ( Ki )

i=1

This grand z-score tests for an overall departure from the expected values across all time
series simultaneously. The individual z-scores test for unimodal clustering within each
time series. You must examine the individual z-scores before concluding whether a significant grand z-score is due to unimodal clustering in all of the time series, or to some
other combination of temporal pattern across time series.
The overall P-value for K across the simultaneous time series is obtained by comparing
the grand z-score to the percentiles of the normal distribution.
Note:

• The grand z-score is not biased by differences in population size across time series.
• K will also be large when occupied time intervals form several clusters, and Larsen’s
method thus cannot distinguish a uniform distribution from multiple clusters.
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Larsen’s Method: How to
Choose Larsen’s method from the Analysis menu (Temporal|Single or Several submenus).
In a series of dialogs, ClusterSeer will prompt you to submit the file to analyze. If you
submitted a suitable dataset in the previous analysis, you will jump directly to the
Choose settings step listed below.

Submit data file
1.

ClusterSeer will prompt you to submit the data file (text file or DBF).
If the text file does not include a label, ClusterSeer will use the row number as the
label, which assumes that the sequence of case counts in the file increases with the
row number. Labels are required with DBFs.
If you submit a DBF, ClusterSeer will prompt you to identify which columns in your
file contain the required data. In this case, the columns can be in any order.
If you wish to submit a text file without a header, it should contain group-level data
with the following columns in the following order:

For single time series:
Time Sequence Label

Case Count

(required for DBF files only)

For several time series:

2.

Region Label

Case Count

Case Count

Case Count

(required for
DBF files only)

Time 1

Time 2

Time 3

...

If your data file includes labels, choose Selected data file contains label. If
your data have no labels, select Use study row # as label.

Choose settings
3.

In the Provide data dialog, you may use the Select File button to change your
file choices.
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4.

Enter the number of time series in your dataset. For a single time series, enter 1. For a
several time series, enter the total number of locations where you collected data for
consecutive intervals of equal length.

Run the analysis
5.

After you hit OK, ClusterSeer will establish nearest neighbor relationships. If you hit
Stop at this point, the procedure will cancel.

Then, ClusterSeer will run the Monte Carlo simulation. You may stop the simulations at
any time using the Stop button on the progress bar. The stop button will halt the simulations and the results will be displayed for the number of Monte Carlo runs completed by
the time you pressed the button.
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Larsen’s Method: Results
Plot
Choose Plot from the View menu to view the plot.
ClusterSeer plots the observed statistic K on its expectation E(K) for both the single and
several time series. The time series are the red point or points on the graph. The dashed
blue line is the function K = E(K) describing where observations would be plotted under
the null hypothesis of a random distribution of occupied intervals across the time series.
Unimodal clustering will cause K to be smaller than its expectation, and observations
plot below the dashed line. Examine the results of the significance test for the z-score to
determine whether or not there is unimodal clustering of cases.

Session log
After ClusterSeer performs a Larsen analysis, it will place summary information and
results into the session log.
Parameters and summary statistics for each time series:

• The number of the series
• The number of cells per series
• The test statistic, K, measures the tendency of time periods with at least one case to
form a single cluster in time.

• The expectation of K, E(K)
• The variance of K, Var(K)
• Larsen's method uses the z-score to determine whether occupied time cells within an
area tend to occur in a sequence.

• The Lower-tailed P-value for K is obtained by comparing the z-score to the percentiles of the normal distribution.

• This method uses the Grand z-score, to identify unusual overall pattern over time
which may not necessarily be the same over the individual areas.

• For the multiple time series, ClusterSeer reports an Overall P-value for K across the
simultaneous time series. This value is obtained by comparing the Grand z-score to
the percentiles of the normal distribution.
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Mantel’s Method

Mantel's method (Mantel 1967) quantifies space-time interaction for individual-level data. It does not require specifying critical or threshold distances for
space-time association, unlike Knox's method. The method calculates space
and time distance matrices. The test statistic, r, is the sum of the time distance
multiplied by the spatial distance for all case pairs.

Examples
Chenoweth et al. (2002) used Mantel's test to evaluate the phylogeography of
the pipefish Urocampus carinirostris. They analyzed the similarity in mitochondrial DNA and the geographical distribution of clades in the group,
finding unexpected patterns not predicted by current biogeographic hypotheses. Schmucki et al. (2002) examined the spatio-temporal relationships
among hedgerows in three different agricultural landscapes in Quebec (195897). They found significant differences among landscapes that they associated with changes in agricultural techniques and management during that
period.
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Mantel’s Method: Statistic
Ho

The times of occurrence of the health events are distributed
randomly across the case locations. This is another way of
saying the time distances between pairs of cases are independent
of the spatial distances between pairs of cases.

Ha

Pairs of cases near in space tend to be near in time.

Test statistic
Mantel's test statistic, Z, is the sum, across all case pairs, of the time distance multiplied
by the spatial distance. Z is also called the Mantel product.

N

Z =

N

∑ ∑ sij tij
i = 1j = 1

Where

• N is the number of cases
• sij is the distance between i and j in space, s is the average space distance, and ss is the
standard deviation of sij

• tij is the distance between i and j in time, t is the average space distance, and st is the
standard deviation of tij.
ClusterSeer uses the standardized version of the Mantel product, r. r is a measure of
matrix correlation with range -1 < r < 1. It is easier to interpret than Z. Both r and Z
become large when the time distances are linearly dependent on the space distances.

N
N s –st –t
1
ij
ij
------------- -----------r = -----------------------------2
st
( N – N – 1 ) i = 1 j = 1 ss

∑∑
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Significance
Although Mantel (1967) provides an approximation for the variance of Z under the null
hypothesis of no association between space and time, the usual approach is to generate
the distribution of r using Monte Carlo simulations, permuting the elements of one of
the distance matrices while holding the other constant. This is equivalent to repeatedly
scrambling the time observations across the locations, and calculating r each time. This is
done repeatedly to generate a distribution of r under the null hypothesis.
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Mantel’s Method: Transformations
For a contagious disease we expect the small space and time distances to be correlated,
but not the large distances. Once you have performed a Mantel analysis, you can look at
the correlation in the distances using the Plot.
To correct for pattern expected in contagious disease, Mantel recommended transforming the space-time distances to reduce the effect of large ones.
You can transform the space-time distances by adding a constant (the shift) to all of the
distances, and or raising the distance to a power. You can also take the log of the distance.

( d + shift )

power

Here shift is the constant and d is the distance to be transformed. Mantel specifically recommended the reciprocal transformation 1/(d + constant) for transforming contagious
diseases (power = -1). If you specify a transformation, ClusterSeer will report the transformation you specified in the Session log using D to represent spatial distance and T to
represent temporal distance.
The selection of a transformation and constant can be subjective, and the default settings
in ClusterSeer are not to use them (shift = 0 and power = 1). The time distances and the
temporal distances can each be transformed separately.
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Mantel’s Method: How to
Choose Mantel's Method from the Analysis menu. (Spatio-Temporal submenu).
In a series of dialogs, ClusterSeer will prompt you to submit the file to analyze. If you
submitted a suitable dataset in the previous analysis, you will jump directly to the
Choose settings step listed below.
This analysis requires a single file of case event data. Files should follow ClusterSeer general data requirements.

Submit data file
1.

ClusterSeer will prompt you to submit the data file (text file, DBF, or point shapefile).
If you submit a text file with a header, a shapefile, or DBF, ClusterSeer will prompt
you to identify which columns in your file contain the required data. In this case, the
columns can be in any order.
If you wish to submit a text file without a header, it should contain individual-level
data with the following columns in the following order

Space-Time Case File:
case level

case event

case event

(optional unless
you are submitting a DBF)

x-coordinate
(not for shapefile)

y-coordinate
(not for shapefile)

case event timepoint (userdefined integer)

ClusterSeer expects case event timepoints as user-defined integers. See “Temporal data
formats” on page 174.
2.

You will need to specify the coordinate system of the data. If the data are in geographic coordinates, you will also need to choose a distance measurement.

3.

If your data file includes labels, choose Selected data file contains label. If
your data have no labels, select Use study row # as label.

Choose settings
4.

In the Provide data dialog, you may use the Select File button to change your
file choices.
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5.

Enter the distance transformations. See the Transformations section for more
information.

6.

Choose the number of Monte Carlo runs, the number of simulations used to determine statistical significance of the test statistic. The default value is 999.

7.

Enter the significance level you wish to use for the test. The significance level is the
alpha level, the cutoff for statistical significance. The default value is 0.05.

Run the analysis
8.

After you hit OK, ClusterSeer will establish nearest neighbor relationships. If you hit
Stop at this point, the procedure will cancel.

Then, ClusterSeer will run the Monte Carlo simulation. You may stop the simulations at
any time using the Stop button on the progress bar. The stop button will halt the simulations and the results will be displayed for the number of Monte Carlo runs completed by
the time you pressed the button.
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Mantel’s Method: Results
Monte Carlo distribution
You can view the Monte Carlo distribution by choosing MC Distribution from the
View menu.
This histogram shows the reference distribution generated by randomizing the dataset
and recalculating the observed value. The relative position of the observed value of r is
illustrated with a slim, vertical black line.

Map
Choose Map from the View menu. ClusterSeer will display a map of the cases’ spatial
distribution.

If you query one of these points, you can view its label, spatial coordinates, and its
time of occurrence.

Plot
You can view the plot by choosing Plot from the View menu.
This plot is a scattergram of all the temporal and spatial distances used in the analysis. If
you transformed them, it is a graph of the transformed distances, not the raw data.

Session log
After ClusterSeer performs a Mantel analysis, it will place summary information and
results into the session log.

•
•
•
•

The file used
The number of cases analyzed
The transformations you specified
Mantel's r, the standardized test statistic

Monte Carlo results
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• The test statistic r
• The number of Monte Carlo simulations
• The P-value for the test statistic through comparison with the Monte Carlo distribution.
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CHAPTER 29

Moran’s I Method

Moran's I (Moran 1950) is a weighted correlation coefficient used to detect
departures from spatial randomness. Departures from randomness indicate
spatial patterns, such as clusters. The statistic may identify other kinds of pattern such as geographic trend.
Moran's I tests for global spatial autocorrelation in group-level data. Positive
spatial autocorrelation means that nearby areas have similar rates, indicating
global spatial clustering. Nearby areas have similar rates when their populations and exposures are alike. When rates in nearby areas are similar, Moran's
I will be large and positive. When rates are dissimilar, Moran's I will be negative.
Moran's I requires full enumeration of the connections among the observations, which may be a problem when the number of areas becomes large.
When full enumeration isn't possible, use Grimson's method, and estimate
the Grimson input data from a sample of areas. Moran's I is biased by large
differences in population size across areas. Use Oden's Ipop when population
size data are available.

Examples
Cullen et al. (2001) used Moran's I to examine patterns in silver beech, Nothofagus menziesii, population dynamics in New Zealand treelines. They found
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significant patchiness in recruitment of silver beech seedlings. Castresana (2002) used
Moran's I to characterize the pattern of mutation locations on human and mouse chromosomes.
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Moran's I Method: Statistic
Ho

Disease rates are spatially independent, the observed rates are
assigned at random among locations. I is close to zero, depending
on sample size.

Ha

Disease rates are not spatially independent. I is not zero.

Test statistic
Moran's I (Moran 1950) is used to determine whether neighboring areas are more similar
than would be expected under the null hypothesis. Moran's I is:

N, ( j ≠ i )

N

N

∑ ∑

w ij z i z j

i=1 j=1

I = -------------------------------------------------N

2

∑ zi

S0

i=1
where N equals the number of regions, wij is a weight denoting the strength of the connection between areas i and j, zi is the rate in region i centered about the mean rate (using
zi = xi – ave(x); xi is the rate in region i); and So is the sum of the weights.

N

S0 =

N

∑ ∑ wij, i ≠ j
i = 1j = 1

The expectation of I under the null hypothesis is:
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–1
E ( I ) = – ----------------(N – 1)
The expectation becomes close to zero as N increases. The variance of I is determined
under two null hypotheses or assumptions: Normality (denoted N) or randomization
(denoted R). Under assumption N the rates are sampled from a population whose distribution is normal. Under assumption R the rates are random samples from a population
whose distribution is unknown. Assumption N is useful when we have good reason to
believe the observations follow a normal distribution. Assumption R is less restrictive
and, since we often don’t know their theoretical distribution, is appropriate for disease
rates. The variance under assumption N is:

2
2
2
1
Var N ( I ) = -------------------------------------------- ( N S 1 – NS 2 + 3S 0 ) – E ( I )
2
( N – 1 ) ( N + 1 )S 0
Under the assumption R the variance is:
2

2

2

2

N [ ( N – 3N + 3 )S 1 – NS 2 + 3S 0 ] – b 2 [ ( N – N )S 1 – 2NS 2 + 6S 0 ]
2
- – E(I)
Var R ( I ) = --------------------------------------------------------------------------------------------------------------------------------------------------------------(3) 2
( N – 1 ) S0

where a falling factorial is written
and where

•

2

b2 = m4 ⁄ m 2
N

•

m4 = 1 ⁄ N

∑
i=1
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(b)

= s ( s – 1 ) ... ( s – b + 1 ) ,
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N

•

2

∑ zi

m2 = 1 ⁄ N

i=1

1

• S 1 = --2

N N, j ≠ 1

∑ ∑

( w ij + w ji )

2

i=1 j=1
N

• S2 =

∑

( w i• + w •i )

2

i=1
Note: For S2, the positioning of the bullet symbol
umns or rows within the matrix. For instance,
across rows, and

w •i

(•)

w i•

indicates whether to add col-

symbolizes the sum of elements

symbolizes the sum of elements within columns.
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Moran's I Method: Significance
ClusterSeer evaluates the significance of Moran's I under assumptions R and N, and also
by Monte Carlo simulations. See page 20 of the first ClusterSeer user guide for more
information on calculating Monte Carlo P-values.
For assumptions N and R ClusterSeer calculates two z-scores as:

I – E(I)
z N = -----------------------Var N ( I )

and

I – E( I)
z R = -----------------------Var R ( I )

These z-scores express the difference between the observed and expected value of I in
standard deviation units. The distribution of the z-scores is approximately normal with a
mean of 0 and a variance of 1.0. ClusterSeer reports a two-tailed P-value because spatial
pattern is of interest both when Moran's I is positive (rates in connected areas are similar) or negative (rates in connected areas are dissimilar).
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Moran's I Method: How to
Choose Moran’s I method from the Analysis menu. (Spatial|Global submenus).
In a series of dialogs, ClusterSeer will prompt you to submit the file to analyze. If you
submitted a suitable dataset in the previous analysis, you will jump directly to the
Choose settings step listed below.

Submit data file
1.

ClusterSeer will prompt you to submit the data files (either a shapefile or a text data
file and a contiguity file, see p. 43 of the first ClusterSeer User Guide for more information on contiguity files).
If you submit a shapefile or text file with a header, ClusterSeer will prompt you to
identify which columns in your file contain the required data. In this case, the columns can be in any order.
If you wish to submit a text file without a header, it should contain group-level data
with the following columns in the following order:
Centroid
label

Disease rate

(optional)
2.

If your data file includes labels, choose Selected data file contains label. If
your data have no labels, select Use study row # as label.

Choose settings
3.

In the Provide data dialog, you may use the Select File button to change your
file choices.

4.

Choose the number of Monte Carlo runs, the number of simulations used to determine statistical significance of the test statistic. The default value is 999.

5.

Enter the significance level you wish to use for the test. The significance level is the
alpha level, the cutoff for statistical significance. The default value is 0.05.
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Run the analysis
6.

After you hit OK, ClusterSeer will establish nearest neighbor relationships. If you hit
Stop at this point, the procedure will cancel.

Then, ClusterSeer will run the Monte Carlo simulation. You may stop the simulations at
any time using the Stop button on the progress bar. The stop button will halt the simulations and the results will be displayed for the number of Monte Carlo runs completed
by the time you pressed the button. Often, the analysis runs so quickly that you will not
see the stop button appear.
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Moran's I Method: Results
Monte Carlo distribution
You can view the Monte Carlo Distribution by choosing MC Distribution from the
View menu.
The histogram shows the reference distribution generated by randomizing the dataset
and recalculating the observed value. The relative position of the observed value of
Moran’s I is illustrated with a slim, vertical black line.

Plot
You can view the plot by choosing Plot from the View menu.
The simulated P-value plot shows how the significance of the test statistic changes with
the number of Monte Carlo randomizations performed. What you will usually see is that
the p-value decreases from near p=1.0 to an asymptote before it reaches the number of
randomizations you specified in the analysis.
If it decreases to the asymptote after few randomizations, you specified a greater number
of randomizations than was required to fix the P-value.
If it is still jumping around a lot, you may wish to rerun the analysis with a greater number of randomizations to fix the P-value.

Session log
After ClusterSeer performs a Moran's I analysis, it will place summary information and
results into the session log.
Cluster Seer reports information on the files used including: file name(s), number of
regions, total number of regions uniquely identified, and average disease frequency.
Moran's I results

• The value of the test statistic, Moran's I
• The expected value of Moran’s I under the null hypothesis (E[I])
• The alpha level at which the test was performed
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Normality Assumption results
ClusterSeer reports the variance, the z-score, and the significance of the z-score,
obtained from a look-up table.
Randomization Assumption results
ClusterSeer reports the variance under the randomization assumption, the z-score calculated using this variance, and the significance of the z-score, obtained from a look-up
table, S0 (the sum of the weights), S1 (A sum used to calculate the variance), S2 and b2.
Monte Carlo results

• The value of the test statistic, Moran's I
• The number of Monte Carlo simulations
• The two-tailed P-value for the test statistic through comparison with the Monte
Carlo distribution.
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CHAPTER 30

Oden’s Ipop Method

Oden (1995) adapted Moran's I to consider population size, developing a
new statistic, Ipop. Ipop is used to detect departures from spatial randomness,
but, unlike Moran's I, it accounts for differences in population size across
areas. If ignored, large differences in population size decrease the ability of
Moran's I to detect true clustering or departures from spatial randomness.
Like Moran's I, Ipop explores the global spatial pattern of group-level data.

Example
Fosgate et al. (2002) investigated spatial clustering in human brucellosis in
California using the Oden's Ipop. They found significant spatial clustering
brucellosis cases in several time periods and in several populations.
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Oden's Ipop Method: Statistic
Ho

Disease rates in connected areas are independent. The geographic
variation in the number of cases is expected to follow geographic
variation in population size.

Ha

Disease rates in connected areas are not spatially independent.
Geographic variation in the number of cases does not follow
geographic variation in population size.

Test Statistic
Moran's I (Moran, 1950) is a weighted correlation coefficient used to detect departures
from spatial randomness. Moran's I is used to determine whether neighboring areas are
more similar than would be expected under the null hypothesis. Oden (1995) adjusted
Moran's I to account for differences in population size across areas. Use Ipop when population size data are available.
Ipop requires a fair amount of notation. In essence, Ipop is large when there is clustering
within a region or among adjacent regions.

N

2

m

m

∑∑

i = 1j = 1

m

m

i–1

i=1

wij ( e i – d i ) ( e j – d j ) – N ( 1 – 2b ) ∑ w ij e i – Nb ∑ w ii d i

Ipop = ----------------------------------------------------------------------------------------------------------------------------------------------------------------S0b( 1 – b)

Where:

• m represents the number of locations or areas
• N is the total number of cases in all of the areas
• n i is the total number of cases in area i

ni
• e i is the proportion of cases in area i  e i = ----

N
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• X is the total size of the risk population in all areas
• x i is the size of the risk population in area i

xi
--• d i is the proportion of the population in area i, d i = X
• e i – d i is the difference between the proportion of cases in area i and the number
of cases expected given the area’s population size

N
X

1
b(1 – b)

• b is the average prevalence, b = ---- ; b 2 = -------------------- – 3
2
• S 0 = X A – XB
3
2
• S 1 = X E – 4x F + 4XD
• w ij is a weight denoting the strength of connection between areas i and j , developed from neighbor information.

m
• A =

m

∑ ∑ di dj wij
i = 1j = 1
m

•

B =

∑ di wii
i=1
m

• C =

m

∑∑

d i d ( w ij + w ji )
j

2

i = 1j = 1
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m

•

D =

∑

2

d i w ii

i=1

• E =

∑ di ∑ ( wij + wji )
j=1

j=1
m
• F =

2

m

m

m

∑ di wii ∑ dj ( wij + wji )

j=1

j=1

m
• G =

∑ ei wii

i=1
m
• H =

m

∑ ∑ wij ( ei – di ) ( ej + dj )

i = 1j = 1

The expectation of Ipop under the null hypothesis (no clustering) approaches zero for
large total population:

–1
E ( Ipop ) = ----------------(X – 1)
The range of Ipop depends on population size, therefore t can be useful to standardize
the statistic using the average prevalence, for comparison among different study areas.
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Ipop
Ipop' = -----------b
The variance of Ipop can be determined based on a random distribution, appropriate for
disease rates (Cliff and Ord 1981). ClusterSeer calculates the variance in two ways. The
variance of Ipop under the null hypothesis is:
2

2

2

2

X [ ( X – 3X + 3 )S 1 – XS 2 + 3S 0 ] – b 2 [ X S 1 – 2XS 2 + 6S 0 ]
2
Var R ( Ipop ) = ------------------------------------------------------------------------------------------------------------------------------------------------– E ( Ipop )
(3) 2
( X – 1 ) S0

It also calculates an approximation of the variance

( Var A ) :

2 c
2A + --- – E
2
Var A ( Ipop ) = ----------------------------2 2
A X
Significance
ClusterSeer evaluates the significance of Ipop using several approaches: using the zscores, variance and multinomial Monte Carlo randomization. In general, these methods
will report relatively similar p-values. The approximation and randomization assumption
methods are only valid when the data can be assumed to be distributed normally. When
the data may not be normally distributed, use the Monte Carlo P-value instead.
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Oden’s Ipop Method: How to
ClusterSeer requires information on disease frequencies, population-at-risk and neighbor
relationships to run Oden's Ipop. You can submit this data as two text files: a disease frequency file and an associated contiguity file. Currently, you cannot run an Oden’s Ipop
analysis with a DBF file.
Choose Oden’s Ipop method from the Analysis menu (Spatial|Global submenus).
In a series of dialogs, ClusterSeer will prompt you to submit the file to analyze. If you
submitted a suitable dataset in the previous analysis, you will jump directly to the
Choose settings step listed below.

Submit data file
1.

ClusterSeer will prompt you to submit the data files (either a shapefile or a text data
file and a contiguity file, see p. 43 of the first ClusterSeer User Guide for more information on contiguity files)
If you submit a shapefile or text file with a header, ClusterSeer will prompt you to
identify which columns in your file contain the required data. In this case, the columns can be in any order.
If it is a text file without a header, it should contain group-level data with the following columns in the following order.
Centroid label

Case count

(optional)
2.

Population at risk
count

If your data file includes labels, choose Selected data file contains label. If
your data have no labels, select Use study row # as label.

Choose settings
3.

In the Provide data dialog, you may use the Select File button to change
your file choices.

4.

Choose the number of Monte Carlo runs, the number of simulations used to determine statistical significance of the test statistic. The default value is 999.

5.

Enter the significance level you wish to use for the test. The significance level is the
alpha level, the cutoff for statistical significance. The default value is 0.05.If you run
mulitiple tests at the same significance level, you can then choose to run a Multiple
Comparisons analysis to determine the proper significance level for all comparisons.
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Run the analysis
6.

After you hit OK, ClusterSeer will establish nearest neighbor relationships. If you hit
Stop at this point, the procedure will cancel.

Then, ClusterSeer will run the Monte Carlo simulation.You may stop the simulations at
any time using the Stop button on the progress bar. The stop button will halt the simulations and the results will be displayed for the number of Monte Carlo runs completed
by the time you pressed the button.
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Oden’s Ipop Method: Results
Monte Carlo distribution
You can view the Monte Carlo distribution by choosing MC Distribution from the
View menu.
The histogram shows the reference distribution generated by randomizing the dataset
and recalculating the observed value. The relative position of the observed value of Ipop
is illustrated with a slim, vertical black line.

Plot
You can view the plot by choosing Plot from the View menu.
The simulated P-value plot shows how the significance of the test statistic changes with
the number of Monte Carlo randomizations performed. What you will usually see is that
the p-value decreases from near p=1.0 to an asymptote before it reaches the number of
randomizations you specified in the analysis.
If it decreases to the asymptote after few randomizations, you specified a greater number
of randomizations than was required to fix the P-value.
If it is still jumping around a lot, you may wish to rerun the analysis with a greater number of randomizations to fix the P-value.

Session log
After ClusterSeer performs an Ipop analysis, it will place summary information and
results into the session log.
Information on the files used including the file name(s), number of regions, cases, and
population-at-risk.
Oden’s Ipop results

• The value of the test statistic, Ipop
• The standardized version of Ipop, Ipop'
• The expected value of Ipop under the null hypothesis
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• The percent within: the proportion of the test statistic that is attributable to clustering within the area

• The percent among: for adjacent areas, whether those adjacent areas are similar in
their level of excess
Approximation
ClusterSeer reports the approximated variance, the z-score, and the significance of the zscore, obtained from a look-up table.
Randomization Assumption results
ClusterSeer reports the variance under the randomization assumption, the z-score calculated using this variance, and the significance of the z-score, obtained from a look-up
table.
Monte Carlo results

• The test statistic (Ipop')
• The number of Monte Carlo simulations
• The P-value for the test statistic through comparison with the Monte Carlo distribution.
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CHAPTER 31

Scan Method

The Scan method (Wallenstein 1980 1987) tests for temporal clustering in
single and several time series with group-level data. Use the Scan method
with case counts, not rates. The data can be relatively sparse or numerous.
The time series must be at least five time cells in length.
You can analyze several time series at once using time series files containing
several series. However, the P-values for each series will not be combined to
yield an overall P-value. The test is biased by changes in population size
through time, which can cause significance even when underlying clustering
is absent.

Example
Vredevoe et al. (1999) investigated the temporal distribution of equine granulocytic ehrlichiosis in California. They found seasonal clustering in the cases
that parallels the life history of the Ixodes pacificus tick, indicating it is the most
plausible vector among those considered.
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Scan Method: Statistic
Ho

Cases occur at random across the time series.

Ha

Cases cluster in some time periods.

Test statistic
The test statistic S w is the maximum number of cases appearing in a pre-defined window as it is moves continuously along a time series. This number must be an integer. For
example, for this time series
01200201
and a window width or size of 2, S w is 3. The significance of S w is obtained by numerical approximation.
The test is most sensitive to clustering when the scanning window is the same width as
natural clusters in the data. When the cases are clustered, the maximum number of cases
in the scanning window will be large.
ClusterSeer calculates expected values, significance values, and the normal approximation variance to help you evaluate the significance of the test statistic.
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Scan Method: Significance
Statistical significance arises when many cases occur in one cell or when time cells with
many cases fit within the scanning window. S w is larger than its expectation when cases
cluster in a few time cells. S w is smaller than its expectation when cases are uniformly
distributed among the time cells.
When this method was developed, computers were too slow to generate Monte Carlo
randomizations. Today, the simulated Monte Carlo P-value is easily computed and appropriate to use in all but a few instances. For example, if you have a very large dataset, you
should use the normal approximation, instead. The normal approximation is appropriate
if the window size is large relative to the total time-series length, and if there is a sufficient number of cases. To be consistent, ClusterSeer continues to calculate and report the
truncated estimate and Wallenstein and Neff P-value.
Options for the expectation under the null hypothesis and P-values are: truncated Wallenstein and Neff (TE[Sw]), normal approximation (NE[Sw]), and the Monte Carlo simulations (SE[Sw]).

TE[Sw]
The Truncated Wallenstein and Neff formula, TE[Sw] is

N

E ( Sw ) ≈

∑ P ( j ;w, T, N )

j=1
Where:

N : Number of cases
T : Number of time periods
w : Window width
S w : Maximum number of cases observed in w as it is slid along the time series
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Wallenstein and Neff (WN) P-Value significance: The probability of observing, under
the null hypothesis, an Sw given the window width w, T time periods and N cases is
approximated by (Wallenstein and Neff, 1987):
N

P ( m ;w, T, N ) ≈ ( m T ⁄ w – N + 1 )b ( m ;N, w ⁄ T ) + 2

∑

b ( j ;N, w ⁄ T )

j=m+1

n–j
n j
b ( j ;n, p ) =   p ( 1 – p )
 j

 n is a binomial coefficient. P ( j ;w, T, N )
 j

is the probability of obtaining, under

the null hypothesis, a scan statistic greater than or equal to j. This probability is onetailed.

NE[Sw]
NE[Sw] is the normal approximation to Wallenstein and Neff's formula shown in the
previous section on Truncated Wallenstein and Neff.
N P-value is the normal approximation P-value. The statistics tend to become asymptotically normal when you use the normal approximation.
ClusterSeer also calculates the normal approximation variance.

SE[Sw]
SE[Sw] is the Monte Carlo simulation estimate. The simulation estimate is obtained by
randomly distributing cases into time slots, over and over again for the number of Monte
Carlo runs, and then running the Scan statistic on all those examples. The mean of these
repetitions is SE.
S P-value is the Monte Carlo simulation P-value. The P-value corresponds to the proportion of results more extreme than the result of the given data.
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Scan Method: How to
Choose Scan method from the Analysis menu (Temporal|Single or Several
submenus).
In a series of dialogs, ClusterSeer will prompt you to submit the file to analyze. If you
submitted a suitable dataset in the previous analysis, you will jump directly to the
Choose settings step listed below.

Submit data file
1.

ClusterSeer will prompt you to submit the data file (either a text file or DBF).
DBFs must have a column of labels. If you submit a text file without a label column,
ClusterSeer will use the row number as the label, which assumes that the sequence of
case counts in the file increases with the row number.
The text or DBF file should contain group-level data with the following columns in
the following order:

For single time series:
Time Sequence Label

Case Count

(required for DBF files only)

For several time series:

2.

Region Label

Case Count

Case Count

Case Count

(required for
DBF files only)

Time 1

Time 2

Time 3

...

If your data file includes labels, choose Selected data file contains label. If
your data have no labels, select Use study row # as label.

Choose settings
3.

In the Provide data dialog, you may use the Select File button to change your
file choices.

4.

Enter the window size for your time series. See the previous Scan Statistic section for
details.

5.

Enter the total number of time series. If you are running a single time series, specify
1. For multiple time series, specify the total number of time series in your study.
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6.

Choose the number of Monte Carlo randomizations, the number of simulations used
to determine the statistical significance of the Test Statistic.

Run the analysis
7.

After you hit OK, ClusterSeer will establish nearest neighbor relationships. If you hit
Stop at this point, the procedure will cancel.

Then, ClusterSeer will run the Monte Carlo simulation.You may stop the simulations at
any time using the Stop button on the progress bar. The stop button will halt the simulations and the results will be displayed for the number of Monte Carlo runs completed
by the time you pressed the button.

296

Scan Method: Results

Scan Method: Results
Monte Carlo distribution
You can view the Monte Carlo Distribution for both the single and several time series by
choosing MC Distribution from the View menu.
The histogram shows the reference distribution generated by randomizing the dataset
and recalculating Sw. Sw is illustrated in red, and it is compared with the distribution for
estimating the one-sided P-value.

Plot
A graph of the Sw on its expectation is shown for the multiple testing regions. When Sw
equals its expectation the test is not significant and a line with a slope of 45 degrees
results. When clustering exists Sw is large relative to the expected value and the points will
be above the 45 degree line.
Under uniformity (e.g. an equal number of cases in each time periods), Sw will be small
relative to its expectation and the points will be below the 45 degree line.

Session log
After ClusterSeer performs a Scan analysis, it will place summary information and results
into the session log.
Data and analysis input for each time series

• N: the total number of cases in the time series
• Sw: the Scan statistic is the maximum number of cases appearing in a pre-defined window as it moves continuously along a time series.
Results

• The truncated Wallenstein and Neff expectation of the scan statistic (TE[Sw])
• The normal approximation to the expectation of the scan statistic (NE[Sw])
• The normal approximation variance, which measures the dispersion of a distribution
about its mean value
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• The simulated estimate of expectation of scan statistic (SE[Sw]): ClusterSeer performs a Monte Carlo randomization of the data by shuffling the labels for each of the
spatial locations.
P-values

• Wallenstein and Neff P-value: the probability of observing, under the null hypothesis,
an Sw given the window width w, T time periods and N cases.

• Normal P-value is the normal approximation P-value: the statistics tend to become
asymptotically normal when you use the normal approximation.

• ClusterSeer generates simulation P-values for the Monte Carlo randomization for
each time series. This is a way to compare the observed Sw to the distribution of Sw
based on a random distribution of the data.
ClusterSeer also reports a list of time series it was unable to analyze.
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Glossary

A
alpha level: Synonym for significance level, a probability threshold used for evaluating a null hypothesis.
alpha parameter: A parameter used to determine the shape of the raised density function in Diggle's
method.
alternative hypothesis: An alternative to the null hypothesis, a different prediction defined either in terms
of the null spatial model or in terms of additional parameters to define "clustering".
alternative spatial model: An alternative to the null spatial model. It can be very basic, "not the null spatial
model," or it can be a more specific model defining a particular disease distribution.
autocorrelation (spatial): Positive spatial autocorrelation means that nearby areas have similar rates, indicating spatial clustering. Nearby areas have similar rates when their populations and exposures are
alike.
average disease frequency: Disease frequency estimated from the dataset itself, the ratio of the total case
count over the total population at risk.
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B
baseline disease frequency: Used as a reference to evaluate suspected change in disease frequency. A
national or historic frequency may be used as the expected frequency or it may be estimated as the
average frequency calculated for the study population under investigation.

C
calendar-based intervals: Any method for recording times for temporal data that is based on the calendar
year, such as daily, weekly, monthly, or yearly intervals. User-defined data is not directly based on
the calendar.
case: A study subject that has experienced a health-related event (usually identified as disease diagnosis).
Case data may catalog individuals, or cases may be aggregated into groups for disease frequency or
case count data.
case-control status: Indicated with a 1 (integer) if subject is a case and 0 if subject is a control
case count: The number of cases in a particular location, at a particular time, or both.
census data: Information from surveys of population size reported for various years. Within ClusterSeer,
census data can be used to estimate population-at-risk size.
cluster: An aggregation of disease in space, in time, or in both space and time, often considered the same as
a 'disease outbreak'
contiguity relationship: Continuity, or the state of being so near as to be touching. Within ClusterSeer,
two regions are defined as contiguous if they share a common border. See rook and/or queen.
control: A study subject that has not experienced the health-related event under investigation.These subjects are considered to represent all individuals at risk of illness and are used for comparison purposes to uncover factors that may influence risk of disease.
coordinate system: A method for representing spatial location. Within ClusterSeer, spatial information
can be represented using any planar projection and geographic coordinates, though geographic
coordinates are transformed to UTM for analysis.

D
data format: Within ClusterSeer, data format refers to the data import requirements for different types of
data.
data type: Within ClusterSeer, data type refers to the unit of observation in the dataset: whether it describes
individuals or groups.
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dataset: The observations used for analysis. The dataset for a particular method may be found in one or
several files.
disease frequency: Measurement of a change in health status (disease state); usually calculated as an incidence proportion by dividing the case count by the population-at-risk count. It may be calculated
locally (over time or over space) for comparison to either the average or expected disease frequency.

E
e: E stands for "exponent" in scientific notation. For example, 3e-005= (3.0 X 10 raised to the negative 5,
or 0.00003). Note that ClusterSeer uses as many zeros as necessary as placeholders for exponential
values.
ego: A target region, in defining spatial weight files.
expected disease frequency: A disease frequency value supplied by you when specifying a ClusterSeer
method. It is usually estimated from another population, for comparison with the study data.
extrapolation: A set of processes for estimating values in between and outside of samples. Within ClusterSeer, you may extrapolate census data with linear or step methods.

F
focus: Point location of potential environmental exposure. ClusterSeer offers methods for evaluating the
pattern of disease relative to a focus.

G
global clustering: As used within ClusterSeer and its help, global clustering methods are tests that evaluate
clustering by looking at spatial patterns throughout the entire study area. Contrast with local or
focused methods.
group-level data: A data type where units of observation are collections of study subjects aggregated over
geographic regions and/or temporal intervals. Compare to individual-level data.

I
individual-level data: A data type where the units of observation are subjects that are cases or controls.
Compare to group-level data.
inhomogeneous: Not uniform.

307

intensity: Determines the expected number of points or cases per unit area for Poisson point process null
models.
interquartile distance: The difference between the values for the 25th-percentile and the 75th-percentile
of a distribution. Used in the local Moran method.

L
label: When importing data, labels are used to match data imported in separate files. The term can also
refer to editable text labels on the axes of histograms and plots.
local clustering: As used within ClusterSeer and its help, local clustering methods are tests that evaluate
clustering by looking at the level of individual cases or regions within the study area. Contrast with
global or focused methods.

M
Monte Carlo Randomization (MCR): A computationally intense method that estimates probability values through resampling the dataset. MCR involves repeatedly reassigning observations to sample
locations in a random way, according to a particular null hypothesis, and recalculating the statistic
for the sets of randomized data.

N
nested: A polygon completely contained within another polygon, a nested polygon only shares borders
with the polygon that contains it.
null distribution: The distribution of the test statistic based on the null hypothesis. It can be derived
empirically through Monte Carlo randomization or through distribution theory.
null hypothesis: A prediction based on the null spatial model.
null spatial model: Defines the distribution of cases of the disease expected without clustering.

O
one-tailed P-value: A P-value obtained by comparing the test statistic to one end of the reference distribution. Most ClusterSeer methods are one-tailed, focusing on the upper tail. They test for clustering,
for where test statistics will be higher than expected.
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P
P-value: The probability that the observed test statistic was drawn from the null distribution, or the probability that the null hypothesis is true given the observed statistic.
point data: Data from individual spatial locations. Points may represent the locations of individual disease
cases, or they may represent region centroids for group-level data.
polygon data: Data representing regions as areas.
polygon, nested: A polygon completely contained within another polygon, a nested polygon only shares
borders with the polygon that contains it.
polygon, self-intersecting: A polygon is called "self-intersecting" when two or more of its borders intersect anywhere except their endpoints. Make sure to prepare your data with a GIS data editor so
that it contains no self-intersecting polygons.
population-at-risk: The individuals considered at risk for the health event (i.e. disease) under investigation.
This value serves as a reference population during cluster analysis. Populations-at-risk may also be
divided into subpopulations (i.e. based on location or age) and these subpopulation counts can
serve-as or contribute-to the units of analysis. If a disease is rare, the cases may be included in the
population-at-risk as would be expected with census data.

Q
queen contiguity: Two regions are defined as contiguous under the queen criterion if they share a border
of any length, even a single point such as a corner. Compare to rook.

R
reference distribution: A distribution of the test statistic under the null hypothesis, usually obtained by
Monte Carlo simulations or from distribution theory.
region: Within ClusterSeer and its help file, the term region is used to indicate an area represented by
aggregate data. While a region may be outlined with borders, its data is often assigned to its centroid.
region centroid: A point that informally represents a sample area, used for data aggregated within geographic regions. The observations from that region (such as case count, population at risk count)
are located to the centroid. Within ClusterSeer centroids are used to establish inter-region distances.
relative risk: The proportional change in risk after exposure, the risk after exposure divided by the baseline
risk.
risk: The average probability of disease developing in an individual during a specified time interval.
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rook contiguity: Two regions are defined as contiguous under the rook criterion if they share a border of
any length greater than a single point. Compare to queen.

S
self-intersecting: A polygon is called "self-intersecting" when two or more of its borders intersect anywhere except their endpoints. Make sure to prepare your data with a GIS data editor so that it contains no self-intersecting polygons.
significance level: A probability threshold used for evaluating a null hypothesis.
spatial weights matrix: A way to represent contiguity relationships between study regions. Each matrix
element corresponds to the relationship for a pair of regions.
study area: The entire geographic extent of the data. The study area may be subdivided into regions, represented by aggregate data. Alternatively, the data may describe spatial locations for individual data.
susceptible: Individuals who could contract the studied disease. These individuals may be included in an
analysis as the population-at-risk or controls.

T
test statistic: A value summarizing an aspect of the data.

U
upper-tail P-value: A P-value obtained by comparing the test statistic to the end of the reference distribution where the statistic's values are highest. Most ClusterSeer methods are one-tailed, focusing on
the upper tail. They test for clustering, where test statistics will be higher than expected.

W
weight: A value used to alter the influence of another variable. Within ClusterSeer, weights are used for
edge correction in Ripley's K-function, to specify neighbor relationships for Local Moran and
Moran's I, and to include distance from a focus in Lawson and Waller's Score or between neighboring regions in Rogerson's Spatial Pattern Statistic.

Z
z-score: A method of standardization that involves subtracting the expected value (i.e., mean) and dividing
by the standard deviation. Z-scores can be interpreted as the number of standard deviation units
from the expected value.
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A

A

test statistic Grimson’s method 226
test statistic, Dat’s method 188
Adjacent 200
Adjust for population size 162
Angular concentration 196
Autocorrelation, see Spatial
autocorrelation
B

Bitmap (*.bmp) 170
Bonferroni combined P-value 213
Branches 196
Breaking ties 164, 165
C

Case count 160
Case data, see Individual-level data
Case-Control data
methods for 162, 177
Cell 212

ClusterSeer User Guide 2

Centroid
distance from 169
Chain of infection 196
Chi-squared test 189, 204, 213
Close 163, 239
Cluster detection
global 158
local 159
space-time interaction 161
spatial 158
temporal 160
Conditional randomness 166
Constant 266
Controls 162
Count data
methods for 211
Count data, see Individual-level data
Covariates 162, 281
Critical
spatial distance 239
temporal distance 239
CSR file 170
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Index

Cuzick & Edwards’ method
instructions 181
overview 177
results 183
statistic 178
D

Dat’s method
instructions 190
overview 187
results 192
statistic 188
DBF
export 170
import 173
Dcrit 244
Directed time measure 200
Direction method
instructions 198
results 201
statistic 196
Disease frequency 160, 162
Distance
critical 239
matrices 264, 266
Distance, statistical 169
E

Exact permutation 204
Exact values, Ederer-MyersMantel 205
Expected number 187
Export
data 170, 171
histogram as image 170
map 171
plot as image 170
results 170
shapefile 171
F

Following 200
G

Getis-Ord Local G, see Local G
Gi and Gi* 218
Global clustering, see Cluster
detection, global
Grimson’s method
instructions 228
overview 225
results 230
statistic 226
Group-level data
global spatial methods for 158, 217,
281

local spatial methods for 159, 245
space-time methods for 161
temporal methods for 203, 211, 255

E

test statistic Empty Cells
method 212
Ederer-Myers-Mantel method
instructions 206
overview 203
results 208
statistic 204
Empty Cells method
instructions 214
overview 211
results 216
statistic 212
Estimate values, Ederer-MyersMantel 205
Event count 160
Event frequency 160, 162
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H

High-risk events 225
Histogram
export 170
I

I 273
Image 170
Import file formats
DBF 173
Shapefile 173
Individual-level data
global spatial methods for 158, 177

Index

space-time methods for 161, 195,
231, 237, 263

Interpolated values 205
Ipop 282
Ipop, see Oden’s Ipop
J

J

statistical distance test statistic 169
Jacquez’s k-NN test
instructions 234
overview 231
results 236
significance 233
statistic 232
Jk
Jacquez’s k-NN test statistic 232

Likelihood ratio 247
Local clustering, see Cluster detection,
local
Local G
instructions 220
overview 217
results 222
significance 219
statistic 218
M

Larsen’s method test statistic 257
k-Nearest neighbor test, see Jacquez’s
k-NN
k-nearest neighbors
in space 163
in time 164
Knox’s method
instructions 241
overview 237
results 243
statistic 238
Kulldorff’s Spatial Scan
instructions 249
overview 245
results 251
statistic 247

M1 204
m1, Ederer-Myers-Mantel test
statistic 204
Mantel product 232, 264
Mantel’s method
instructions 267
overview 263
results 269
significance 265
statistic 264
Map legend 173
Mapping data 172
Matrix
distance 264, 266
space-time 232, 264
Monte Carlo randomizations
statistical distance test statistic 169
types 166
Moran’s I
instructions 277
overview 271
results 279
significance 276
statistic 273
Multinomial randomization 166

L

N

K

K

Labels in DBF files 173
Label-swapping randomization 166
Larsen’s method
instructions 260
overview 255
results 262
statistic 257

N P-value 293
NE(Sw) 293
Nearest neighbor
in space 163
in time 164
several 163, 164
Normal randomization 167
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Index

O

S

Oden’s Ipop
instructions 286
overview 281
results 288
significance 285
statistic 282
Overall P-value, see P-value, overall.

S P-value 293
S(w) 292, 293
Scan
spatial, see Kulldorff’s spatial scan
spatio-temporal, see Kulldorff’s
spatial scan
temporal, see Temporal scan
SE(Sw) 293
Shapefile
export 171
import 173
Shift 266
Shuffling distances 168
Simulated values 204
Simultaneous clustering 160, 203, 211,

P

Plot
export 170
P-value, see P-value.
Poisson randomization 166, 167
Poisson statistic
Kulldorff’s spatial scan 247
Population size 160, 162, 281
Power 266
Project
Save project 170
Proximity 163
P-value
overall 189
plot 183
R

r

standardized Mantel’s test
statistic 264
Randomization
space-time 168
spatial 166
temporal 167
Randomize distances 166
Rare events
methods for 211
Rates, see Group-level data
Reciprocal transformation 266
Relative 200
Restart session
Start over 173
Risk
label 225, 228
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213, 255

Space-Time interaction 195
Spatial autocorrelation 218
Spatial clustering, see Cluster
detection, spatial
Spatial feature file 172
Spatio-temporal clustering, see Cluster
detection, space-time
interaction
Statistical distance test statistic 169
Swap labels 166
Swapping adjacencies 168
T

Table values 204
Tcrit 244
TE(Sw) 293
Temporal clustering, see Cluster
detection, temporal.
Temporal scan method
instructions 295
overview 291
results 297
significance 293
statistic 292
Threshold 239
Ties 164, 165
Time connection matrix 196
Time series
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methods for 160, 187, 211, 255
several 160
single 160
Tk
Cuzick & Edwards’ test statistic 178
statistical distance test statistic 169
Transformation 266, 267
U

Unoccupied cell 212
V

V

test statistic, Direction method 196
Variance values, Ederer-MyersMantel 205
W

Wallenstein & Neff’s Scan, see
Temporal scan
wij 218
X

X

Knox’s method test statistic 238

Z

Z

Mantel’s test statistic 264
z-score
in spatial methods 179, 226, 276, 285
in spatio-temporal methods 226
in temporal methods 188, 226, 258
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